
  

  

USER MANUAL 

v1.0 

Information and help: support@starviewer.udg.edu 



 

2019-07-15 

USER MANUAL 

v1.0 

1 

1. STARVIEWER 6 

2. CONTACT US 7 

3. SAFETY INFORMATION 9 

4. SPECIAL OPERATING INSTRUCTIONS 11 

5. STUDY MANAGEMENT 12 

5.1. Searching for and retrieving studies 12 

5.1.1. Local database 12 

5.1.2. PACS servers 15 

5.1.2.1. Operation list 16 

5.1.3. DICOMDIR 17 

5.1.4. Access from RIS 18 

5.2. Exportation of studies 19 

5.2.1. Anonymisation of studies 19 

5.2.2. Recording to CD/DVD 20 

5.2.3. Recording to USB 20 

5.2.4. Recording to hard disk 21 

6. IMAGE VISUALISATION: 2D VIEWER 22 

7. BASIC VISUALISATION 24 

7.1. Image navigation and layout 24 

7.1.1. Opening studies 24 

7.1.1.1. Hanging Protocols 24 

7.1.1.2. Automatic layout 24 

7.1.1.3. Criteria for the selection of the layout mechanism 24 

7.1.2. Comparison of studies 25 

7.1.3. Related studies 26 

7.1.4. Manipulation of the layout and content of viewers 28 

7.1.4.1. Layout manipulation tools 28 

7.1.4.2. Tools to select the content of the viewer 33 

7.1.5. Viewer enlargement 34 

7.2. Image manipulation tools 36 



 

2019-07-15 

USER MANUAL 

v1.0 

2 

7.2.1. Scrolling 36 

7.2.2. Phase change 37 

7.2.3. Zooming 38 

7.2.4. Magnifying glass 39 

7.2.5. Panning 40 

7.2.6. Changing the window 41 

7.2.7. Selection of default windows 42 

7.2.8. Custom defined windows 43 

7.2.9. Selection of colour functions 45 

7.2.10. Reversing colours 46 

7.2.11. Changing orientation 47 

7.2.11.1. Image flipping 47 

7.2.11.2. Image rotation 48 

7.2.12. Reset to initial state 49 

7.2.13. Information layers management 50 

7.2.13.1. Textual information 50 

7.2.13.2. Overlays 51 

7.2.13.3. Shutters 52 

7.2.14. Screenshot 53 

7.2.15. Exporting DICOM images 54 

7.3. Measurement tools 57 

7.3.1. Distance 57 

7.3.2. TA-GT 58 

7.3.3. Angle 59 

7.3.4. Open angle 60 

7.3.5. Regions of interest (ROI) 61 

7.3.5.1. Elliptic ROI 61 

7.3.5.2. Polygonal ROI 61 

7.3.5.3. Magic ROI 63 

7.3.6. Circle 63 

7.3.7. Erasing 64 

7.3.8. Considerations on geometric measurements 65 

7.3.8.1. Units and types of measurements 65 

7.3.8.2. Measurements in pixels 65 

7.3.8.3. Measurements in millimetres 65 

7.3.8.4. Priority of the measurements 67 



 

2019-07-15 

USER MANUAL 

v1.0 

3 

7.3.8.5. Measurements verbosity 67 

7.3.8.6. Accuracy and precision 68 

8. ADVANCED VISUALISATION 69 

8.1. Reconstructions 69 

8.2. Thick Slab 69 

8.3. Reference lines 71 

8.4. 3D cursor 72 

8.5. Video 73 

8.6. Voxel information 73 

8.7. DICOM information 74 

8.8. Manual synchronisation 76 

8.9. Manual synchronisation in all viewers 76 

8.10. Deactivating manual synchronisation in all viewers 77 

8.11. Automatic synchronisation 77 

8.12. Propagation 77 

8.13. Fusion 84 

8.13.1. Fusion layout 85 

8.14. Fusion balance 87 

8.15. Standardised Uptake Value (SUV) measurement 88 

8.15.1. Formulae 88 

8.15.1.1. SUV 88 

8.15.1.2. Decay correction factor 88 

8.15.1.3. Lean body mass 89 

8.15.1.4. Body surface area 89 

8.15.1.5. Bibliographical sources 89 

8.15.2. Required data 90 

8.15.2.1. Manufacturer exclusive attributes 90 

8.16. MPR 2D viewer 90 

8.17. 3D viewer 93 

8.18. Cutting planes 94 

8.19. 3D rotation 96 

8.20. External applications 96 

9. DIAGNOSIS TESTS 98 



 

2019-07-15 

USER MANUAL 

v1.0 

4 

10. DICOM PRINTING 100 

10.1. Selecting images to print 101 

10.2. Adding a printer 101 

11. THE MENUS 104 

11.1. File menu 105 

11.2. Visualisation menu 105 

11.3. Tools menu 107 

11.4. Window menu 108 

11.4.1. Move to screen 108 

11.4.2. Maximise to multiple screens 108 

11.4.3. Move to adjacent screen 109 

11.4.3.1. Move to previous screen 109 

11.4.3.2. Move to next screen 109 

11.5. Help menu 110 

12. CONFIGURATIONS 111 

12.1. 2D viewer configuration 111 

12.2. 2D viewers layout configuration 112 

12.3. PACS configuration 113 

12.3.1. PACS servers 113 

12.3.2. Local Configuration 114 

12.4. Local database configuration 116 

12.5. RIS configuration 118 

12.6. DICOMDIR configuration 119 

12.6.1. DICOMDIR creation configuration 119 

12.6.2. CD/DVD burning application configuration 119 

12.6.3. Copy folder content to DICOMDIR 119 

12.7. External applications configuration 121 

13. SHORTCUTS 122 

13.1. Main shortcuts 122 

13.2. Other important shortcuts 122 

14. GLOSSARY 124 



 

2019-07-15 

USER MANUAL 

v1.0 

5 

  



 

2019-07-15 

USER MANUAL 

v1.0 

6 

1. STARVIEWER 

Starviewer is a medical imaging visualisation application that satisfies DICOM protocol. 

It supports different modalities: X-ray, CT, magnetic resonance, mammography, radio fluoroscopy, and ultrasound, amongst others. 

It can communicate with any PACS server, or obtain images from external files. 

It can also be integrated into a RIS. 

 

Starviewer is made by: 

 

 

Institut de Diagnòstic per la Imatge 

Parc Sanitari Pere Virgili 

Esteve Terradas, 30 — Edifici Mestral 2a planta 

08023 Barcelona, Spain 

http://idiweb.gencat.cat 

idi@idi.gencat.cat 

Tel. +34 93 259 41 75 

Fax +34 93 259 41 85 
2797 

  

http://idiweb.gencat.cat/
mailto:idi@idi.gencat.cat
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2. CONTACT US 

For any doubt, suggestion, please send an email to: 

 

support@starviewer.udg.edu 
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3. ELECTRONIC INSTRUCTIONS FOR USE 

You can self-print a copy of these instructions for use using the printing function of your PDF reader, nonetheless, you can request a 

printed copy them at support@starviewer.udg.edu which will be served free of charge within 7 days. 

 

Newer, current and older versions of instructions can be downloaded at https://starviewer.org/eifu. We recommend accessing the 

instructions from the “help” menu in order to ensure the right ones are visualized. 

 

  

mailto:support@starviewer.udg.edu
https://starviewer.org/eifu
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4. SAFETY INFORMATION 

 
Read this user manual. 

 

You must read this user manual before using Starviewer for diagnosis purposes. 

 

 
Do not rely solely on Starviewer for critical decisions. 

 

Medical imaging devices are not bug free, and the images and data you are presented arise from a complex chain of devices, each 

one adding risks. Whenever you make a critical decision for a patient you should consider supporting it with additional information 

from other sources in order to minimize as much as possible a scenario where a software bug that is unnoticed and shows plausible 

data to the user which ends up founding a critical decision to the patient that may lead to death or irreversible damage. 

 

 
Contact support if you observe suspicious results. 

 

If you are using Starviewer and you observe strange results that you suspect may be wrong, you should contact support at 

support@starviewer.udg.edu to report the potential problem as soon as possible. You should also try to open the same study with an 

alternative software if possible to check if the same result is obtained. 

 

 
Do not rely solely on Starviewer in emergency situations. 

 

If you need high availability in order to respond in emergency situations, you shall have a contingency plan in order to continue 

diagnosing in case some parts in your chain of devices fail. This can range from your capturing devices, the network, up to the 

visualization workstations. 

 

In the specific case of Starviewer, recommended contingency measures could range from having the ability to diagnose from the 

capturing devices workstations to being able to transfer studies to USB drives in case of network/PACS failure. Unlike 

centralized/cloud visualization solutions, Starviewer is a decentralized piece of software, where each visualization workstation is 

independent from each other. 

 

 
Calibrate your displays to ensure a correct visualization. 

 

The correct visualization of medical images requires taking measures in order to ensure that what you display is consistent with what 

the human user perceives. You shall calibrate your displays, ensure their performance, use medical displays, do periodic checks, 

etc. 

 

 
Do not use the hardware above its specified limits. 

 

Starviewer is a software piece that needs to be executed in a general purpose computer hardware. You need to ensure that the 

hardware operates within the specified manufacturer parameters such as vibration, altitude, environmental radio interference, 

temperature, humidity, radioactivity, etc. 

 

mailto:support@starviewer.udg.edu
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Image quality may temporally degrade during interaction. 

 

For the sake of performance and interactivity, image quality may be temporally degraded during interactions. It will be reversed to 

the maximum quality when the interaction finishes. 
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5. SPECIAL OPERATING INSTRUCTIONS 

No special operation is required, just normal operation following this user manual. 
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6. STUDY MANAGEMENT 

6.1. SEARCHING FOR AND RETRIEVING STUDIES 

The application allows users to search for studies from three different sources: 

 

- Local database: It allows users to search for retrieved or imported studies on the computer. 

 Menu: File > Local Database Studies... 

Shortcut: CONTROL+L 

 

- PACS server: It allows users to search for studies from one or more PACS. 

Menu: File > PACS... 

Shortcut: CONTROL+P 

 

- DICOMDIR: It allows users to search for studies that are stored in a DICOMDIR to the computer, or to any other device (USB, CD, 

DVD). 

Menu: File > Open DICOMDIR... 

Shortcut: CONTROL+D 

 

From the same window that appears when searching in any of the three options, users can search in any of the other options by 

simply selecting the tab corresponding to the place where they want to search for the studies. 

6.1.1. Local database 

In order to search for studies in the local database, it can be accessed in two different ways: 

- From menu File > Local Database Studies... 

- Pressing the shortcut keys CONTROL+L 

And a dialogue box appears as the one shown below: 
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This tab shows the studies that are stored in the computer where users are working, and that have been retrieved from a PACS or 

from a DICOMDIR. 

 

In order to search in the local database, different filters can be applied, such as: patient name, patient ID, date of the study or 

modality. 

 

Studies are displayed in the form of a list, where they can be selected using the arrow on the left of the folder in order to expand the 

information about the series they contain. The studies can be sorted by any of the attributes shown in the list by clicking on the title 

of the corresponding column. The sorting option is saved according to the last configuration applied. 

 

 
 

To perform a multiple selection of studies, the CONTROL key must be held down while performing the selection of the list. If there is 

more than one selected study, the operations carried out will affect all the selected studies. 

 

By selecting one or more studies, different operations are allowed: 

- View: It opens the selected studies, organising the viewers and the series automatically in the case it finds an appropriate viewers 

layout (Hanging Protocols). 
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This operation can also be performed by using the keyword with the CONTROL+V keys, by clicking with 

the RIGHT BUTTON of the mouse on the study, or by double clicking on any series of the study. 

 

By clicking with the RIGHT BUTTON of the mouse on a study or a series, different actions can also be 

performed: 

 

 
 

- View: It performs the same operation as the View button: it visualises the selected studies, organising 

the viewers and the series automatically in the case it finds an appropriate viewers layout (Hanging 

Protocols). 

- Delete: It deletes the selected studies or series of the list from the studies locally stored. This operation 

can also be performed by selecting and pressing the Delete key. 

- Send to DICOMDIR List: It exports the files (the data) of the study in DICOMDIR format in order to 

record it on a USB, CD, DVD, hard disk... To do so, first it is necessary to send all the studies to the 

DICOMDIR list by using this functionality, and then export it together (see section Exportation of studies). 

This operation can also be performed by selecting the study and pressing the CONTROL+M keys. 

- Send to PACS: It sends the selected studies or series to the selected PACS. By selecting the option 

Send to PACS, or by pressing the CONTROL+S keys, a dialogue box with the PACS we have configured 

appears such as the one shown below: 

 

 
 

From this dialogue box we will be able to choose the PACS where we are going to send the selected 

elements. Once the selection has been performed, we will send the elements by clicking the Send 

button. If the PACS does not appear in the list, it can be configured as a new PACS (see section PACS 

configuration). 

 

 

 

RIGHT BUTTON 
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6.1.2. PACS servers 

In order to search for studies in one or several PACS servers, they can be accessed in two different ways: 

- From menu File > PACS... 

- Pressing the shortcut keys CONTROL+P 

And a dialogue box appears as the one shown below: 

 

 
 

From the PACS Server tab, users can search for patient studies that are stored in the configured PACS list. 

To configure new PACS, see section PACS configuration. 

 

By default, searches are carried out in the PACS that, when configured, have been flagged with the option 

Default Query PACS. In order to visualise in which PACS is searched by default, users have to choose the 

option PACS Nodes (ICON 1), and the list of activated PACS appears in the upper-right corner of the window. 

The selected PACS are the ones that are activated and, hence, the ones where the studies will be searched in. 

 

Different filters can be applied to perform the search, such as: patient name, patient ID, date of the study and 

series modalities. 

 

By selecting the option Advanced Search (ICON 2), it is allowed to apply other criteria such as: patient birth 

date, patient age, study time, study UID, study modality, series UID, SOP Instance UID... 

Once the parameters have been specified, we have to select the option Search (ICON 3) and all the results that 

match the chosen options will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 1 

 
 

 

 

ICON 2 

 
ICON 3
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If during a search users want to cancel it, they will have to click the Cancel query (ICON 4) button. 

 

Once the search is completed, different actions can be performed: 

- Retrieve & View: It retrieves the study locally and visualises it automatically once retrieved. This 

operation can also be performed directly by clicking with the RIGHT BUTTON of the mouse on the study 

that has to be visualised, and selecting the option Retrieve & View, or by using the CONTROL+V keys. 

- Retrieve: It retrieves the selected study/series/image (one or more) and stores it locally. This operation 

can also be performed by clicking with the RIGHT BUTTON of the mouse on the study that has to be 

visualised and selecting the option Retrieve, or by using the CONTROL+R keys. 

 

The retrieving status of each requested study can also be checked by selecting the option of the ICON 5, 

Operation List (see next section Operation list). 

6.1.2.1. Operation list 

All the studies that are being retrieved, the ones pending to be retrieved, the retrieved ones, the ones 

that are being sent, the ones pending to be sent, the sent ones, the ones that are being cancelled, the 

ones pending to be cancelled and the cancelled ones can be consulted in the operation list by pressing 

ICON 5 from the PACS Server tab (see previous section PACS servers). 

 

The operation list window shows the status of each study that has been selected to be retrieved or sent. 

 

 
 

The different statuses are: 

- Retrieved: The study has already been retrieved and it can be found in the local database, where it is 
ready to be visualised. 
- Retrieving: This study is being retrieved. 
- Pending: The study is waiting to be retrieved (only one study can be retrieved at a time). 
- Error: There was an error while retrieving the study. 
- Sent: The study has been sent to the PACS. 
- Sending: The study is being sent to the PACS. 
- Cancelling: The study operation is being cancelled. 
- Cancelled: The operation related to the study has been cancelled. 
 

There are also different operations available to perform with the elements of the list: 

- Cancel All: It cancels all the pending operations and the ones that are being executed. 

 

 

ICON 4 

 
 

RIGHT BUTTON 

 
 

 

 

 

 

 

 

 

 

ICON 5  
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- Cancel Selected: It only cancels the selected operations. 
- Clear: Removes from the list all the studies with a retrieved, sent, cancelled or error status. 

6.1.3. DICOMDIR 

In order to search for studies from a CD/DVD, USB, or a hard disk, we have the functionality of importing 

from DICOMDIR. 

 

It can be accessed in two different ways: 

- From menu File > Open DICOMDIR... 

- Pressing the shortcut keys CONTROL+D 

 

A dialogue box is shown that allows users to search for the DICOMDIR file in any directory. Once the 

DICOMDIR has been opened, the DICOMDIR tab is shown with all the studies that it contains, such as 

the one shown below: 

 

 
 

Different actions can be performed with the elements of the list: 

 

- View: Visualises the selected study. This operation can also be performed directly by clicking with the 

RIGHT BUTTON of the mouse on the study that has to be visualised, and selecting the option View, or 

by pressing the CONTROL+V keys. 
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- Import: It imports the selected study/series/image (one or more) storing it locally. This operation can also be performed directly by 

clicking with the RIGHT BUTTON of the mouse on the study that has to be imported, and selecting the option Import, or by pressing 

the CONTROL+R keys. 

6.1.4. Access from RIS 

Starviewer can be integrated with a RIS, so that users can choose the study they want to visualise from the RIS without the need for 

doing the search manually. 

 

The connection between Starviewer and the RIS must be well configured. Section RIS configuration contains information about how 

to configure this connection. 

 

To open a study from the RIS, users have to select the button of the study from the RIS. After that, the Starviewer application starts 

(if it was not previously initialised) and a dialogue box is shown that indicates that the search for the studies that have been 

requested from the RIS has begun. 

 

 
 

Once the studies have been found, and before retrieving them, the application checks whether they have already been retrieved in 

the local database. In case they are already retrieved in the local database, users are asked whether they want to retrieve them 

again. 

 

 
 

If users reply in the affirmative, the study is retrieved again by updating the study located in the local database, and then the study is 

opened; otherwise, if users reply in the negative, or they remain silent for some seconds, the application automatically visualises the 

study of the local database without retrieving it again. 

In case the study does not exist in the local database, it is retrieved and automatically visualised. 

 

When a study is being retrieved, the initial dialogue box indicates the evolution of the retrieval, that is, the studies that have been 

retrieved and the ones pending to be retrieved. 

 
This dialogue box automatically disappears once the retrieval is complete. If users want to make it disappear during the retrieval 

process, they can click with the left button of the mouse on the dialogue box. 

 

If for some reason the retrieval cannot be carried out (the study does not exist...), the same dialogue box reports the error. 
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6.2. EXPORTATION OF STUDIES 

In order to export the data of one or more patients in DICOM format, it is first necessary to select which 

studies will be exported. To select the studies to be exported, the local database has to be opened 

through File>Local Database Studies... or by pressing the shortcut keys CONTROL+L. 

 

A list with the studies we have in the local database appears, so these are all the studies we can export. 

We need to select all the studies we want to export; to select more than one study of the list at the same 

time, we have to press the CONTROL key while selecting studies from the list. Once they are selected, 

we have to click with the RIGHT BUTTON of the mouse on one of the selected studies and choose the 

option Send to DICOMDIR List, or press the shortcut keys CONTROL+M. 

 

 
 

Once sent, we have to select the option Create DICOMDIR (ICON 1), and the following window appears: 

 

 
 

This window allows us to select the device where we want to export the data: 

- CD/DVD 

- USB 

- Hard disk 

 

The application allows us to add the whole content of a specific folder into the exported data, such as a 

viewer that allows the visualisation of the images, or additional information to the study, in any format 

(reports, for example). This directory is previously configured, and the information about how to do so 

can be consulted in section DICOMDIR configuration. 

6.2.1. Anonymisation of studies 

It is possible to convert the patient data into anonymous data when exporting them. To anonymise the 

 

 

 

 

 

 

 

 

 

RIGHT BUTTON 

 
 

 

 

 

 

 

 

 

ICON 1 
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data, the option Anonymize DICOMDIR studies has to be selected, and a new name for the patient (maximum 

64 characters) has to be chosen. This name will be applied to all the patients being exported at that time; it can 

also be left blank. It is recommended to anonymise the studies if they have to be sent outside the hospital. 

6.2.2. Recording to CD/DVD 

Please follow the steps of section Exportation of studies. 

 

Once we see the list of studies in the queue to record in DICOM format, we have to choose ICON 1 (CD) or 

ICON 2 (DVD) and select the option Create. 

 

 
 

The program that has been configured to create the CD or the DVD, whose configuration can be found in the 

panel of DICOMDIR configuration, automatically opens. 

6.2.3. Recording to USB 

Please follow the steps of section Exportation of studies. 

 

Once we see the list of studies in the queue to record in DICOM format, we have to choose ICON 3 and then 

select ICON 4 to find the location within the USB where we want to save the studies of the list. Once the location 

to save the DICOMDIR has been selected, we have to select the option Create. 
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6.2.4. Recording to hard disk 

Please follow the steps of section Exportation of studies. 

 

Once we see the list of studies in the queue to record in DICOM format, we have to choose ICON 1 and then 

select ICON 2 to find the location within the hard disk where we want to save the studies of the list. Once the 

location to save the DICOMDIR has been selected, we have to select the option Create. 
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ICON 2 
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7. IMAGE VISUALISATION: 2D VIEWER 

The 2D viewer is the module that allows us to visualise the images from the studies of practically every kind of image modality such 

as CT, MR, MG, RF, CR, and US, amongst others. It allows us to perform a wide range of basic and advanced actions on the loaded 

images. A summary of the most outstanding functions is shown below: 

 

Visualisation management 

- Choosing the visualisation mode in a custom way (number of opened studies, placement of images...) 

- Visualising the list of related studies that the patient has 

 

Basic manipulation 

- Images movement in spatial and temporal dimension 

- Zooming 

- Magnifying glass 

- Image rotation 

- Image flipping: vertical and horizontal 

- Reversing colours 

- Reset a viewer to its initial state 

- Hide patient information from the viewer 

- Save a screenshot in image format (.jpg, .png, .bmp, .tiff) 

- Send images to a PACS 

 

Performing different measurements: 

- Distances, TA-GT 

- Angles, Open angles 

- Elliptic ROI, Polygonal ROI, Magic ROI, Circle (Regions of interest) to compute areas and average grey values 

- Erasing performed measurements 

 

Advanced functions: 

- Orthogonal reconstructions: Axial, Sagittal, Coronal 

- Thick Slab (MIP, MinIP, average) 

- Reference lines 

- 3D cursor 

- Visualising images as a video 

- Checking the information of a single voxel 

- DICOM additional information 

- Synchronisation: automatic and manual 

- Propagation of zooming, window, orientation, panning... 

- Fusion of PET-CT and SPECT-CT images 
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To learn more about each function, please check Basic visualisation and Advanced visualisation chapters. 
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8. BASIC VISUALISATION 

8.1. IMAGE NAVIGATION AND LAYOUT 

8.1.1. Opening studies 

When we load a study, the application is responsible for automatically distributing its content in a set of viewers. To carry out this 

procedure, there are two complementary mechanisms: the Hanging Protocols and the automatic layout. Details are explained below. 

8.1.1.1. Hanging Protocols 

The Hanging Protocols are templates that allow us to define a layout for the viewers where the content of each viewer is given by a 

series of restrictions and conditions that the images of the studies we load must comply with. 

 

This allows us to perform automatic layouts in accordance with almost any study. The most typical example would be the 

mammographies, where the Hanging Protocols allow us to create several templates to show the different projections with the layout 

we want, such as the comparison with craniocaudal, oblique or even prior mammographies. The same is applicable to any image 

protocol. 

8.1.1.2. Automatic layout 

This mechanism creates a regular viewers layout according to the image modality of the study, so that the maximum amount of 

sequences or images can be placed if desired. 

 

Starviewer provides a default configuration for each modality, which is summarised below: 

- It will create as many viewers as images or series contained in the study, up to a maximum of 48 viewers distributed in 6 rows and 

8 columns 

- The layout direction will be from left to right, in ascending order, starting from the sequences with the oldest date 

- For plain X-ray images (CR, DX, RF, ES, OP, XA, XC, etc.), the layout will be done by images 

- For the rest of modalities (CT, MR, PT, etc.) the layout will be done by series, excluding Surveys (MR) and Locators (CT) 

 

The layout configuration is adjustable and we can have a specific one for each image modality. The options that we can modify for 

each modality are the following: 

- Distributing by images or by series 

- Layout direction (from left to right or from top to bottom) 

- Maximum number of viewers (it can be set between 2 and 48, or as many as possible up to a maximum of 48) 

- Exclusion of Surveys (MR) and/or Locators (CT) 

 

All these parameters can be modified from the configuration menu of the 2D viewers layout. 

8.1.1.3. Criteria for the selection of the layout mechanism 

Every time a new study is loaded, it is necessary to choose whether to apply a Hanging Protocol or an automatic layout. Next, the 

criteria followed to determine the layout system applied is explained. 

 

When a new study is loaded, the internal library of Hanging Protocols templates is checked and, according to the properties of the 

loaded study, those that can be candidates for being applied according to the restrictions defined in each template are filtered. In this 

case, two scenarios are possible: 
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- The filtering process results in one or more candidate Hanging Protocols. In this case, the Hanging Protocol that better complies 

with the restrictions is applied. The rest of candidate Hanging Protocols can be chosen later by users through the viewers layout tool 

if they want. 

- The filtering process results in no candidate Hanging Protocol. In this case, the automatic layout according to the content of the 

study is applied. 

 

On the other hand, we can also choose that, even if there are candidate Hanging Protocols, these can only be applied for the 

modalities we choose through the 2D viewers layout configuration options. In this case, the automatic layout according to the content 

of the study is applied. Additionally, we will have the candidate Hanging Protocols available and we will be able to apply them later 

using the viewers layout tool. By default, the modalities where the application of Hanging Protocols will be a priority will be CR, CT, 

MG, MR and US. 

 

If we load studies from different modalities, the best Hanging Protocol from those modalities that have it as a preferential layout will 

be applied. In the event that we have no Hanging Protocols, the automatic layout applied will be the result of the combination of the 

automatic layout configurations of each modality. The criteria to combine the properties of the automatic layout configurations will be 

the following ones: 

- If the layout criterion (by images or by series) is different, the series criterion will be applied. 

- If the layout direction criterion (from left to right or from top to bottom) is different, the left to right criterion will be applied. 

- The maximum number of viewers will be the minimum of the set of configurations to be combined. 

- All the excluding criteria that have been included in each configuration will be included. 

8.1.2. Comparison of studies 

Function: It allows the visualisation of two studies of the same patient side by side to compare them. The most recent study is 

considered as the current one, and the oldest study as the prior one. 

 

Shortcut to activate it: F10 

 

Mode of operation: The comparison mode is activated by selecting a prior study in the related studies tool, and it is disabled by 

unselecting the prior study in the same tool. Alternatively, if the current study is a mammography or a CR of the thorax, the 

comparison mode can be activated and disabled by pressing the shortcut key F10. In this case, the most recent prior study of the 

same type (mammography or CR of the thorax) is selected automatically, and if none exists, the comparison mode is not activated. 

 

When the comparison mode is activated or when the current or prior study is changed while it is activated, the application first looks 

for an existing combined Hanging Protocol (that is, that combines images from two studies at the same time) that is applicable to 

both selected studies, and if it is found it is applied. If no applicable combined Hanging Protocol is found, then the Starviewer window 

is divided in two halves where the left half corresponds to the current study and the right half to the prior one; for each study, a 

regular layout or an individual Hanging Protocol is applied in accordance with the criteria explained in section 5.1.1.3. 

 

Viewer where it is applied: All of them; when the comparison mode is activated, the layout of the whole window changes. 



 

2019-07-15 

USER MANUAL 

v1.0 

26 

8.1.3. Related studies 

 

 
 

Function: It shows the list of related studies of the current patient that can be found in the local database, in 

the PACS selected by default, and in the PACS where the study comes from, and it allows users to change 

the current and prior studies. 

 

Mode of operation: When clicking on the icon, the list of related studies that have been found appears. 

From this list users can change the displayed study and activate or disable the comparison with a prior 

study. The selection buttons of the Current and Prior columns allow users to change respectively the 

current and prior studies that are displayed at every moment. Only a more recent study than the prior one 

selected can be chosen as the current study, and only an older study than the current one selected can be 

chosen as the prior one; in any other case the selection button does not appear. 

 

To change the current study, users must click on the selection button corresponding to the new study in the 

Current column. To add or change a prior study to compare, users must click on the selection button 

corresponding to the new study in the Prior column. When a study is selected as current or prior, if it is not 

in memory, it is automatically retrieved from the PACS or it is loaded from the local database. To disable 

the comparison and view only the current study, users must click on the marked selection button in the 

Prior column. To load a study from the list to memory without viewing it, users have to select ICON 1 of the 

desired study. 

 

The list is sorted by study date in descending order (from newest to oldest). The order can be changed by 

clicking on the desired column (Name, Modality, Description...). 

 

The search for related studies is performed in the local database, in the PACS selected by default, and in 

the PACS where the study comes from (see section PACS configuration). All the studies that have the 

same patient ID are considered as related studies. It is possible to change the configuration by including 

also the studies with the same patient name; in this case, users have to contact the Starviewer 

administrator in order to activate this functionality. 

 

The studies from the list may be in different statuses: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 1 
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- Selected as current or prior: Selection button checked in the Current or Prior column (ICON 1). 

- Available to be selected as current or prior: Selection button unchecked in the Current or Prior column 
(ICON 2). 

- Not available to be selected as current or prior: No selection button in the Current or Prior column. 

- In memory: ICON 3 in the third column. 

- Retrieving or pending retrieval: ICON 4 in the third column. 

- Available to be retrieved from the PACS or loaded from the database: No icon in the third column. 

 

The studies with the same modality as the displayed study are highlighted. 

 

Viewer where it is applied: Once the current or prior study selected has been retrieved, it is automatically 

loaded. If only one study is visualised, without a prior one, the new images layout and placement of viewers 

is decided as explained in the section Criteria for the selection of the layout mechanism. If two studies are 

shown, the current and the prior ones, the criteria explained in the section Comparison of studies are 

followed. 

 

Example: 

We open a study, we click on the related studies icon, and a list of found cases appears. 

 

     
 

We select another study as the current one by clicking on its selection button in the Current column. Once 

opened, it applies the default viewers layout to the new study. 

 

     
 

We select a prior study to compare it by clicking on its selection button in the Prior column. Once opened, it 

applies a layout combining both studies. 

 

ICON 1 

 
ICON 2 

 
ICON 3 

 
ICON 4 
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If no related studies of the patient are found, the following message is shown: 

 

 
 

 
If the application reports that no related studies have been found, it does not mean that there is 

none. It may be that in a PACS not configured to search for by default some studies can be found, 

or that the name contains typographical errors and they are not found either. 

 

8.1.4. Manipulation of the layout and content of viewers 

Once the studies have been loaded, we have some tools to modify the applied layout and adjust both the 

content and their layout. Below, we explain which these tools are. 

8.1.4.1. Layout manipulation tools 

 
 

Function: It creates a viewers layout in accordance with the chosen specification. Two types of 

specifications can be chosen: 

 

- Custom regular layouts: It allows users to select the number of rows and columns to generate a regular 

grid of viewers. The viewers are filled following the automatic layout criteria.  

- Hanging Protocols layouts: If the study has candidate Hanging Protocols, it allows us to choose which one 

we want to apply. 

 

Shortcut keys to activate it: F11 and F12 

 

Mode of operation: 

 

Mouse:  

- Custom regular layouts: Select ICON 1 and move the mouse over the dynamic grid of squares that 

appears. When the highlighted grid is the desired one, press the left button of the mouse. 

- Hanging Protocols layouts: Select ICON 2 and select an element within the Hanging Protocols section. 

The Hanging Protocols are divided in three groups: Hanging Protocols for the current study, Hanging 

Protocols for the prior study, and combined Hanging Protocols. The last two groups are only displayed if the 
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ICON 2 
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comparison mode is active. 

 

Keyboard: With the F11 and F12 keys the previous and next Hanging Protocol can be applied, respectively, inside the same group 

and following the order in which they appear in the menu. 

 

Viewer where it is applied: When only one study is displayed: all of them; the application replaces the whole current layout by the 

selected one. When two studies are compared: if a combined Hanging Protocol is applied, or if there was one already applied, all of 

them; if a regular layout or a Hanging Protocol from a study is applied and there was no combined Hanging Protocol applied, only 

half of the window corresponding to the study in question is affected. 

 

Example of a custom regular layout 

1. Initial viewers layout: 

 

 
 

2. Selection of a different layout, for example a 3x3 layout: 

 

 
 

3. Result obtained: 
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Example of a Hanging Protocols layout 

1. Initial viewers layout: 

 

 
 

2. Activation of the comparison with a prior study. A combined Hanging Protocol is applied by default, in this case Mammo Prev: 

 

 
 

3. Selection of another combined Hanging Protocol, for example MLO-L Prev: 

 

 
 

4. Result obtained: 
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5. Selection of an individual Hanging Protocol for the current study, for example Rights: 

 

 
 

6. Result obtained: the selected Hanging Protocol is applied to the current study and the default one, in this case CC MLO, is applied 

to the prior one: 
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8.1.4.2. Tools to select the content of the viewer 

In order to change the series displayed in a viewer, users have to click with the RIGHT BUTTON of the 

mouse inside the viewer (without moving the mouse), and a list appears with all series available to be 

shown. 

 

 
 

To change the series of the viewer, users only need to select an element of the list (the one highlighted in 

blue or in a darker colour). The element displayed in bold is the series that the viewer contains. 

 

If we load a study from the same patient, either from a PACS, from local studies, or from the Related 

studies tool, it automatically appears in the list of available series, and therefore it can be placed in any of 

the viewers. The studies are ordered from the most recent to the oldest. 

 

If there are series from different modalities that can be merged, the possible fusion combinations that we 

can visualise will appear after the conventional series, flagged with the label Fusion. When we move the 

mouse over a possible fusion combination, the series combined in this fusion will also be highlighted. To 

know more about the conditions under which the fusion options will appear, see chapter Fusion. 

 

 
 

On the other hand, if we are in the last image of the series and we press the + key, the next series will be 

loaded. If we are in the first image of the series and we press the – key, the previous series will be loaded 

instead. This navigation is circular and consecutive within the studies; for example, if we are in the last 

image of the last series of the last study and we press +, we will go to the first image of the first series of 

 

 

RIGHT BUTTON 
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the first study. For more information about the images movement, see chapter Scroll. 

8.1.5. Viewer enlargement 

A viewer can be temporarily enlarged at any time to visualise the image in greater detail. By double clicking on a viewer, it is 

enlarged to fill the whole window or solely one half, depending on whether the main window of Starviewer is on a single screen or 

two, respectively. By double clicking again on an enlarged viewer, it returns to its normal size. 

 

This functionality is always available except when the distance, TA-GT, angle, open angle, polygonal ROI and magic ROI 

measurement tools are enabled. 

 

Example 

1. Normal viewers layout: 

 

 
 

2. Double click on one of the viewers: 
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3. Double click on the viewer: 
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8.2. IMAGE MANIPULATION TOOLS 

8.2.1. Scrolling 

 

 
 

Function: It changes the image of the different slices that form the displayed patient series. The slice number of the displayed slice is 

shown below each viewer on the left side, as well as the total number of slices contained in the series. 

 

Shortcut keys to activate it: S 

 

Mode of operation: 

Mouse: Press the left button while moving the mouse up and down within a 

2D viewer. It can also be used by spinning the mouse wheel in order to have 

a higher accuracy. While it is enabled, the icon appears next to the mouse 

cursor. If we activate another tool, the scroll functionality with the mouse 

wheel remains enabled. 

 

 

Keyboard: 

 

OPTIONS DESCRIPTION 

Next / Previous image Keys  /  

Next / Previous image going through all series Keys + / - 

First image Key HOME 

Last image Key END 

 

Interface: Using the slider placed below each viewer (highlighted in red in the figure). 

 

 
 

 

 
This tool can also be configured to make a cyclic scroll. The configuration process is explained in section 2D viewer 

configuration. 

 

 

Viewer where it is applied: Viewer over which the mouse is moved while the left button is pressed or the mouse wheel is spun, or the 

active viewer while the keys are pressed. 

Left button Wheel  
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Example: 

 

 
 

8.2.2. Phase change 

In dynamic models, where there is more than one image per slice, the phase can be changed at any time. 

 

To perform this operation, the following ways are possible: 

 

Mouse: By using the mouse, and placing the cursor on the active viewer, a click with the middle button of the mouse is done (without 

moving it) and the phase change mode is enabled. From this point, the slice changes (scrolling) are converted to phase changes 

(moving the mouse wheel, or pressing the left button and moving the mouse at the same time). To enable the scrolling mode again, 

the middle button of the mouse must be pressed again. 

 

 
    Initial state       To phase change        Phase change            To scrolling   Scrolling 

 

Keyboard: By pressing the  and  keys the phase is decreased and increased, respectively. 
 

Left button Middle button  
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     Scrolling         Phase change              Scrolling 

 

 

Keyboard + Mouse: If the CONTROL key is held down while the scrolling tool is enabled, the phase is changed instead of the slice. 

 

 
   Scrolling       Phase change        Scrolling 

8.2.3. Zooming 

 

 
 

Function: Increase/Reduce image size 

 

Shortcut key to activate it: Z 

 

Mode of operation:  

Mouse: Pressing the left button of the mouse while moving the mouse up and down within a 2D viewer. 

 

Viewer where it is applied: Viewer where the mouse is moved on while pressing its left button. 

 

Example: 

 

Left button 
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8.2.4. Magnifying glass 

 

 
 

Function: It creates a new window, where it magnifies the area of the image pointed out with the mouse. 

 

Shortcut key to activate it: SHIFT+Z 

 

Mode of operation:  

Mouse: Press the left button while moving the mouse over the image. A new window appears, where 

the area where the mouse points out is magnified. The mouse can be moved within the image, but if 

the mouse is placed outside, the magnifying window disappears. 

 

Viewer where it is applied: Viewer where the mouse is moved on while pressing its left button. 

 

Example: 

 

  

Left button 
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8.2.5. Panning 

 

 
The icon does not appear in the toolbar; it is always available using the mouse. 

 

Function: Moves the image towards the point where the mouse cursor is moved. 

 

Mode of operation: 

 

Mouse: Holding down the middle button while moving the mouse in the direction where the 

image has to be moved. 

 

Viewer where it is applied: Viewer that contains the image where the mouse click has been 

performed. 

 

Example: 

 
 

  

 

Press the left button 

and move the mouse 
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8.2.6. Changing the window 

 

 
For the extensions 2D Viewer and MPR 2D Viewer the icon does not appear in the toolbar; it is always available using the mouse. 

 

Function: Changing the greyscale of the viewer. See also the Selection of default windows tool. 

 

Shortcut key to activate it: W 

 

Mode of operation: 

Mouse: Holding down the right button of the mouse while performing a vertical and/or horizontal movement. 

 

Viewer where it is applied: Viewer that contains the image where the mouse click has been 

performed. 

 

The default window of each image before applying the window change tool corresponds to the 

value defined in the DICOM image, and it can different for each image. Once the window 

change tool has been used, all the images will have the same window. 

 

Example: 

 

 
 

  

 

Press the right 

button and move 

the mouse 
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8.2.7. Selection of default windows 

 

 
 

Function: It changes the greyscale of a viewer according to some previously predetermined windows. Each window is suitable to 

visualise a particular type of study. There are 4 types of default windows: 

 

WINDOW TYPE DESCRIPTION 

Automatic Formed by the element “Auto”, which is available for any type of image. It applies a 

normalised window based on the range of values of the current image. 

Default by DICOM It contains the values defined within the DICOM of the image. A DICOM image may contain 

zero or more default windows. The name of these values is also defined in the DICOM file, 

and if not, they are defined as “Default” plus an ordering number. 

Default by modality It contains values previously defined by the application, and they are designed to visualise 

studies of certain modalities, such as for CT. There are different default values: 

Emphysema, Angiography, CT Neck+Contrast, CT Head, CT Liver, CT Soft Tissues, etc. 

Default by users Formed by the specific and custom values that users have saved. See the functioning in the 

next section Custom defined windows. 

 

Mode of operation: Selecting the viewer where the window change has to be applied and, using the keyboard or the drop-down 

menu, performing one of the steps described below. 

 

Keyboard: Selecting the number that corresponds to the window that has to be applied. 

º: It alternates in a sequential way the automatic windows and the DICOM default ones (Auto, Default 0, Default 1...) 

0: Emphysema 

1: Angiography 

2: CT Neck+Contrast 

3: CT Head 

4: CT Liver 

5: CT Liver+Contrast  

6: CT Bone 

7: CT Lung 

8: CT Soft Tissues 

9: CT Soft Tissues+Contrast 

SHIFT+1: Petrous Bone 
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SHIFT+2: Osteoporosis 

  

Interface: Selecting an element from the drop-down menu, either a value automatically defined, defined in the DICOM, defined by 

the application or defined by the users. 

 

The option “Custom” (at the end of the drop-down menu) allows us to choose the exact values of contrast and brightness to be 

applied to the image. To do so, we have to select the “Custom” option from the drop-down menu, which will display a dialogue box 

such as the one shown in the next image. 

 

 
 

Introduce the values corresponding to the contrast and the brightness, and press the OK button. After that, the chosen values are 

applied to the selected viewer. 

 

To define new values, and keep them permanently, choose the option Edit Custom WW/WL from the drop-down menu. See the 

functioning of this option in the next section Custom defined windows. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

8.2.8. Custom defined windows 

 
 

Option: Edit Custom WW/WL, within the default windows drop-down menu. 

 

Function: It allows users to save, edit and delete new WW/WL values so that they are available each time the application starts. 

 

Mode of operation: Select the option Edit Custom WW/WL from the drop-down menu. A window such as the one shown below is 

displayed:  
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All the values we have stored are displayed in this window. Different options are possible: 

 

Add New: It allows users to add a new value to be stored. 

 

By selecting this option or by pressing the RETURN key, a new line is displayed with the current WW/WL values of the selected 

viewer. We can replace these values by the desired ones, and we can also give them a new name by writing it in the last box. Once 

defined, we have to select OK. 

 

 
 

 
 

The new stored values appear at the end of the default values list. 

 

Remove: It allows users to remove one or more of the stored values. The list allows the selection of multiple values at the same time 

by pressing the control key while clicking on the description field of each value. To remove the elements, select one or more 

elements of the list and press Remove. A dialogue box is displayed asking for a removal confirmation. Press OK to remove the 

value. 

 

Edit: To edit the values the users simply have to change the value in the text box that shows the current value (areas highlighted in 

red in the next image). 
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To finish the changes, and save them permanently, press the OK button. If we have a description without text, or the text is 

repeated, the application will report the error and the changes will not be saved until the error is solved. 

 

If we exit by pressing Cancel or by pressing the red cross of the window, none of the performed changes will be saved. 

 

Viewer where it is applied: New value available to all viewers. 

8.2.9. Selection of colour functions 

 

 
 

Function: It changes the colour function of a viewer according to some default colour functions. Each function is suitable to visualise 

a specific type of study. Currently, there are only colour functions available for studies of PET and SPECT modalities. In PET or 

SPECT images the monochrome inverse colour function (Black & White Inverse) will be applied by default. In PET-CT or SPECT-CT 

fusion images, the PET Osirix colour function will be applied over the PET or SPECT image by default. 

 

Mode of operation: Select the viewer where the colour function has to be applied (if it is not selected yet) and select an element of 

the drop-down menu. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

The same series of PET with different colour functions (Black & White Inverse and PET). 
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8.2.10. Reversing colours 

 

 
 

Function: It inverts the colour scale of the image, that is, the blacks turn white and the whites turn black, the yellows turn blue and 

the blues turn yellow, and so on. 

 

Shortcut key: I 

 

Mode of operation: Select the viewer where the colour transformation has to be applied (if it is not selected yet) and press the icon or 

the corresponding shortcut key. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

 

The image on the left is the original one, and the image on the right corresponds to the original image after applying the colour 

reversal. 
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8.2.11. Changing orientation 

8.2.11.1. Image flipping 

 

 
 

Function: It applies a vertical or horizontal flipping to the image. 

 

Shortcut keys: J (vertical), H (horizontal) 

 

Mode of operation: Select the viewer where the transformation has to be applied (if it is not selected yet) and press the icon or the 

corresponding shortcut key. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example (vertical): 

 

 
 
Example (horizontal): 
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8.2.11.2. Image rotation 

 

 
 

Function: It applies rotations of 90º to the image clockwise and anti-clockwise. 

 

Shortcut keys: G (clockwise), F (anti-clockwise) 

 

Mode of operation: Select the viewer that contains the image to which the rotation has to be applied (if it is not selected yet) and 

press the icon or the corresponding shortcut key for each turn of 90º needed. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

The first row of images shows the result of applying the rotation clockwise consecutively. In the second row of images we see the 

effect of applying the rotation anti-clockwise. After applying the action four times, the result returns to the initial state. 
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8.2.12. Reset to initial state 

 

 
 

Function: It returns the image of the viewer to its initial state as if it was reloaded from the beginning. 

 

Shortcut key: CONTROL+R 

 

Mode of operation: Select the viewer that has to be restored (if it is not selected yet) and press the icon or the corresponding 

shortcut key.  

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example:  

The leftmost image is the original image, the image in the middle is the original image after applying a zooming operation, a change 

of scale, adding annotations, etc., and the rightmost image is the result of applying the restoration of the viewer to the middle image. 

We can see that the image is exactly the same it was at the beginning. 
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8.2.13. Information layers management 

8.2.13.1. Textual information 

 
 

Function: It hides or shows the textual information in the viewers (amongst these, patient and study data). If there is information 

printed on the image itself, this information cannot be hidden. 

 

Mode of operation: Select the icon to hide the information, and select it again so that the information reappears. 

 

Viewer where it is applied: All. 

 

Example: 

The image on the left shows a viewer with all the patient information; the image on the right shows the same viewer, but hiding the 

patient information. 

 

 
 

 
This feature is useful if users need to create an image for a presentation and the patient information should not appear, since 

by using the Screenshot tool this information also disappears. 
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8.2.13.2. Overlays 

 

 
 

This feature can be found in the menu of the button to manage textual information (ICON 1). 

 

Function: It shows/hides the information of the overlays. The overlays are a layer of information that contains 

annotations performed over the image. It is a deprecated annotations format, but there are still modalities that 

use it and it may contain important information for the diagnosis. 

 

Mode of operation: Select the icon to hide the information, and select it again so that the information of the 

overlays reappears. 

They are enabled by default. 

 

Viewer where it is applied: All. 

 

Example: 

The image on the left shows a viewer where the overlays are enabled (we can see a ROI, annotation “F” and 

“Tra” in white); the image on the right shows the same viewer, but removing the overlays information. 

 

  

 

 

 

 

 

 

ICON 1 
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8.2.13.3. Shutters 

 

 
 

This feature can be found in the menu of the button to manage textual information (ICON 1). 

 

Function: It cuts out non-important areas of the image to facilitate the diagnosis. They are usually white areas 

that can disturb users when visualising the image. They are common in images of RF modality and plain X-ray. 

 

Mode of operation: Select the icon to show the entire image without removing the margins. Select it again to 

enable the shutters again and, therefore, to remove the margins of the image that may be a nuisance. 

They are enabled by default. 

 

Viewer where it is applied: All. 

 

Example: 

The image on the left shows a viewer where the shutters are enabled; the image on the right shows a viewer 

where the shutters are disabled. 

 

 
  

 

 

 

 

 

 

ICON 1 
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8.2.14. Screenshot 

 

 
 

Function: It saves one or all the images contained in the active viewer in photography format (therefore, DICOM information is 

deleted) anywhere to the computer, or to an external device (USB, hard drive...). The export formats are: PNG, JPG, BMP and TIFF. 

All of them are image formats that can be opened with any machine without the need for specific software. 

 

Shortcut keys: CONTROL+S (current image), CONTROL+A (all the images). 

 

Mode of operation:  

 

Mouse: Select the viewer from which the image or images have to saved, select the screenshot tool, and choose one of the two 

options: Save an image from the current series, Save all images from the current series. A dialogue box is displayed that allows 

users to choose the directory where the image or images will be saved, which is confirmed by selecting Save. 

 

Keyboard:  

- Save an image: Select the viewer from which the image has to be saved (if it is not selected yet), and press the CONTROL+S 

keys. A dialogue box is displayed that allows users to choose the directory where the image will be saved and, after specifying a 

folder and a filename, select Save. 

- Save all images: Select the viewer from which all images have to be saved (if it is not selected yet), and press the CONTROL+A 

keys. A dialogue box is displayed that allows users to choose the directory where the images have to be saved and, after specifying 

a folder and a prefix for the filenames, select Save. 

- It is recommended to save the images in an empty folder, since if the series contains many images, a file is created for each one. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 
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8.2.15. Exporting DICOM images 

 

 
 

Function: It generates a new DICOM series from a capture of the series that is currently displayed. It is stored within the same study. 

The new series can only be stored locally, or sent to one or several PACS. It saves the annotations embedded in the images of the 

series. 

 

Mode of operation: Select the viewer that contains the series that has to be exported (if it is not selected yet) and press the icon for 

creating a new series. A window is opened, which provides different options: 

 

 
 

Series description: It is the description the new series will have. 

 

Images to export: It allows users to choose the images that will be saved. Depending on the series, different options can be chosen: 

- Current image only: Only the displayed image is saved. 

- All images of the series (available if it contains more than one image): It saves all the images that form the series, that is, all the 

slices. 

- All images of the current phase (available if it contains more than one phase and image): It saves the images of all the slices that 

form the displayed phase. 

- All phases of the current image (available if it contains more than one phase and image): It saves the images of all the phases 

corresponding to the displayed slice. 

At the bottom of the image preview, the total number of images to be saved is displayed. 

 

The right part of the dialogue box reports that the images will be stored in the local database and in the selected PACS. 

- If no PACS is selected, images are only stored in the local database and, therefore, they will only be accessible from the machine 

where they have been generated. 

- If one or more PACS are selected, images are stored in the local database and they are also sent to the selected PACS; therefore, 

the images can obtained if they are needed in the future, and they can be accessed from any machine connected to the selected 

PACS. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 
 

Example: 
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1- We perform, for example, an area in one of the viewers, which is the one that will be saved. We can see 

that we can only choose two series from the study. 

 

 
 

2- We select ICON 1 to export the image, and we add a description. We only want to save the current 

image, and only locally, so that we do not select any PACS. Finally, we select Export.  

 

 
 

3- In the patient menu, the new captured series is displayed, and it is available to be visualised in any 

viewer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 1 
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8.3. MEASUREMENT TOOLS 

8.3.1. Distance 

 

 
 

Function: It allows users to compute the minimum distance between two points. 

 

Shortcut key to activate it: D 

 

Mode of operation: 

Mouse: Make a first click with the mouse to assign the starting point, move the mouse, and make a second 

click to assign the ending point. The annotation of the measurement will be placed next to the second point. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Viewer over which the mouse cursor is located. The viewer can be changed 

while creating a distance. 

 

Example: 

 

 
 

  

Left button 
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8.3.2. TA-GT 

 

 
 

Function: It allows users to perform a TA-GT measurement. 

 

Mode of operation: 

Mouse: Make a first click with the mouse to assign the starting point of the line, move the mouse, and 

make a second click to assign the ending point of the line; this line will be the reference line. Once we 

have created this line, we need to create two more lines perpendicular to it. To do so, we have to move the 

mouse and set the point where the second line ends, and repeat the process for the third line. When 

completing the measurement, the line that joins the last two lines, which indicates the distance between 

them, is displayed. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Viewer over which the mouse cursor is located. The viewer can be changed while creating the TA-GT 

measurement. 

 

Example: 

 

 
  

Left button 
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8.3.3. Angle 

 

 
 

Function: It allows users to compute the angle formed by three points. 

 

Shortcut key to activate it: A 

 

Mode of operation: 

Mouse: Make a first click to assign the first point, make a second click to assign the second point (“inflection 

point”), move the mouse until the third point is located, and make a third click to set this last point. The 

result of the measurement will be placed at the origin of the angle. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

 

 
 

Viewer where it is applied: Viewer where the clicks are made. The viewer can be changed while creating an angle. 

 

Example: 

 
 

  

Left button 
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8.3.4. Open angle 

 

 
 

Function: It allows users to create angles without setting the “inflection point”, since it is computed from two lines. 

 

 

Shortcut key to activate it: SHIFT+A 

 

Mode of operation: 

Mouse: It consists in drawing two lines. Make a first click to assign the first point of the first line, and a second click to assign the 

second point of the first line. Once the first two points are set, the same process is repeated to assign the 

two points of the second line. The application computes the angle formed by the two drawn lines. The order 

of the points in the first and the second line is irrelevant. The result will be placed in the dashed line that 

joins the two lines, that is, the place where the angle would be formed. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

 
 

Viewer where it is applied: Viewer where the clicks are made. The viewer can be changed while creating an angle. 

 

Example: 

 

 
  

Left button 
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8.3.5. Regions of interest (ROI) 

Starviewer provides different tools to draw regions of interest with different shapes. Once the region of interest is drawn, the area is 

computed in mm2 (if the image does not have spacing information, it will be computed in pixels2), as well as some statistical data 

such as the mean and the standard deviation. For images with more than one component per pixel (colour image), only the area is 

computed. If the image has specific units, these will be indicated in the statistical data. For images of PET modality, the maximum 

and average SUV will be also computed in the drawn region. In PET-CT fusion images, the SUV of the PET image and the statistical 

data of the CT image will be displayed. To learn more about how the SUV is computed and which methods exist, see chapter 

Standardized Uptake Value (SUV) measurement. 

 

The ROI tools are grouped in the same button in the toolbar. Below, we explain each of the existing ROI tools. 

8.3.5.1. Elliptic ROI 

 

 
 

Function: It allows users to create an elliptic region. 

 

Shortcut key to activate it: R 

 

Mode of operation: 

Mouse: While pressing the left button, move the mouse until the ellipse has the desired size; then, stop pressing the button of the 

mouse. If the movement is done horizontally, the ellipse changes the horizontal diameter; if the movement is done vertically, the 

vertical diameter is changed instead. The result of the measurement is placed at the lower side of the ellipse if it grows from top to 

bottom, and it is placed at the upper side if it grows inversely. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Viewer where the click is made. 

 

Example: 

 

 

 

8.3.5.2. Polygonal ROI 

 

Left button 
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Function: It allows users to create a polygonal region. 

 

Shortcut key to activate it: SHIFT+R 

 

Mode of operation: 

Mouse: Make different clicks with the left button of the mouse, drawing the shape of the area that has to be computed. Double click 

to automatically close the area. The result will be placed outside the polygon as close as possible to the last created point. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Each point has an effect in the viewer where the left button of the mouse is 

pressed. The viewer can be changed even if a ROI is not finished, and when the mouse enters the viewer 

again, it is possible to continue with the creation of the ROI. 

 

Example: 

 
  

Left button 
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8.3.5.3. Magic ROI 

 

 
 

Function: It allows users to delimit a region with similar intensity values within a threshold starting at an initial point. 

 

Shortcut key to activate it: M 

 

Mode of operation: 

Mouse: Click with the left button of the mouse inside the area where the ROI has to be created. Then, while still pressing the mouse 

button, move the mouse vertically up or down until the size of the ROI fits the desired area. When the 

drawn area is the desired one, stop pressing the mouse button, and the information of the chosen area will 

be displayed at the lower side of the ROI. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Viewer that contains the image where the click is made. 

 

Example: 

 

 

 

8.3.6. Circle 

 
 
 

 

The icon is located in the ROI tools drop-down menu. 

 
Function: It allows users to create a circular region by indicating its centre. 

 

Mode of operation: 

Left button 
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Mouse: Move the mouse while pressing its left button, and stop pressing it when the circle has the desired shape. The tool does not 

take into account whether the movement is made horizontally or vertically, since it always keeps the circular shape. The diameter of 

the circle will be the maximum distance between the initial point and the movement made. 

To cancel the measurement when it is still not finished, press the ESC key. 

 

Viewer where it is applied: Viewer where the click is made. 

 

Example: 

 

8.3.7. Erasing 

 

 
 

Function: It erases the annotations (distances, ROI, angles, open angles...) displayed in a viewer. It allows users to: 

- Erase objects one by one 

- Erase objects in a region 

- Erase all objects of a viewer 

 

Shortcut key to activate it: E 

 

Mode of operation: 

 

Mouse: 

ACTION DESCRIPTION 

Erase objects one by one Click with the left button of the mouse on the annotation to be erased. 

Erase objects in a region Hold down the left button of the mouse while moving it to draw the region to be erased. 

All the objects that are completely inside the box are erased. 

Erase all objects of a viewer Select the viewer that has to be cleared (with the margin painted), select the arrow next to 

the rubber icon, and select the option All of current viewer. 

 

Left button 
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Keyboard: The action of erasing all objects of a viewer is available by pressing the CONTROL+E keys. 

 

Viewer where it is applied: Viewer that contains the mouse, or the active viewer (with a darker or blue colour frame). 

 

Example:  

 

8.3.8. Considerations on geometric measurements 

8.3.8.1. Units and types of measurements 

The units displayed in the geometric measurements, mainly distances and ROI, may vary depending on the presence of certain 

DICOM attributes. Additionally, depending on the image modality and according to the present attributes, the application may give 

one or more results for the same measurement, each one with its corresponding meaning. When needed, the type of measurement 

will be explicitly indicated to avoid confusion with the type of measurement omitted. 

 

Next, we explain in which cases each unit and type of measurement may appear. 

 

 
All the geometric measurements will always be displayed together with their corresponding unit, whether pixels (px) or 

millimetres (mm). 

 

8.3.8.2. Measurements in pixels 

The measurements are displayed in pixels (px) when it is not possible to determine the physical space between two consecutive 

pixels. This scenario occurs when the following image attributes are not present: 

- Pixel Spacing (0028,0030) 

- Imager Pixel Spacing (0018,1164) 

 

8.3.8.3. Measurements in millimetres 

In order for the measurements to be shown in millimetres (mm), we need at least one of the following pixel spacing attributes are 

present in the image: 

- Pixel Spacing (0028,0030) 

- Imager Pixel Spacing (0018,1164) 
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In this case, additionally, and depending on the modality, the present attributes and the corresponding values, more than one value 

may be computed in the same measurement, where each one may have a specific meaning. The different types of measurement 

values that may appear and their possible conditions are detailed below. 

 

Physical measurements 

Measurements will be considered as physical when the following conditions are met: 

- the image modality is CT, MR, PT, SC, US or NM 

- the presence of the Pixel Spacing (0028,0030) attribute in the image with a valid value 

 

The Pixel Spacing attribute determines the physical space between two consecutive pixels, which is why the measurement taken on 

the image corresponds to the actual physical measurement of the patient it represents. 

 

Measurements in projection radiography images 

When dealing with projection radiography images (those with CR, DX, RF, MG, XA, XC, IO, OP or ES modality), their own nature 

implies that different spacing attributes can be provided, which makes it possible to interpret different types of measurements. Below, 

the possible scenarios are described. 

 

Measurement in detector 

Measurements will be considered relative to the detector’s plane when one of the following conditions is met: 

 

- The Imager Pixel Spacing (0018,1164) attribute is the only present spacing attribute, or 

- The Imager Pixel Spacing (0018,1164) and Pixel Spacing (0028,0030) attributes are present and have the same value. 

 

For projection radiography images, if no type is explicitly stated, the default measurement is relative to the detector. 

 

Calibrated measurement 

These measurements are possible when the following condition is met: 

- The Imager Pixel Spacing (0018,1164) and Pixel Spacing (0028,0030) attributes are present and have different values. 

 

In this case, Imager Pixel Spacing (0018,1164) will have the spacing corresponding to the detector’s plane, and Pixel Spacing 

(0028,0030) will have a calibrated spacing that will approximate the spacing in the image plane. 

 

This case will allow us to give both measurements, the one from the detector and the calibrated one. If the calibrated one is 

displayed, whether or not together with the measurement from the detector, it will always be displayed together with a label that 

explicitly indicates that the value of the measurements corresponds to the calibration. 

 

Magnified measurement 

This case is similar to that of calibrated measurements, but it is specific to MG modality images. Measurements may be magnified 

when the following conditions are met: 

 

- The image modality is MG 

- The Imager Pixel Spacing (0018,1164) and Estimated Radiographic Magnification Factor (0018,1114) attributes are present in the 

image 
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In this case, the calibration between the detector and the image plane is done by dividing the value of the Imager Pixel Spacing by 

the value of the Estimated Radiographic Magnification Factor. 

 

This case will also allow us to give both measurements, the one from the detector and the magnified one. If the magnified one is 

displayed, whether or not together with the measurement from the detector, it will always be displayed together with a label that 

explicitly indicates that the value of the measurement corresponds to the magnified one. 

 

Unknown meaning measurement 

This scenario occurs when, according to the modality and the present attributes, the meaning of the measurement cannot be 

determined due to the lack of complementary information. For a measure to be considered that way, the following conditions must be 

met: 

 

- The image modality is of projection radiography: CR, DX, RF, XA, XC, MG, IO, OP or ES 

- The only present spacing attribute is Pixel Spacing (0028,0030) 

 

If these conditions are met, the measurement will always be displayed together with a label that explicitly indicates this condition of 

the measurement. 

 

 
Obtaining such a measurement is not normal and would indicate that there is an error or a problem in the data generation of 

the acquired image. This problem should be reported to the technical team of the modality to correct it and generate the data 

properly. 

 

8.3.8.4. Priority of the measurements 

Given the possible types of measurements, in some cases we will have to decide which values we want to show and how. Next, we 

describe the measurements that are computed first according to each case and how they are displayed. 

 

- If the image is of projection radiography: 

- If the measurement comes with no label and is displayed in mm, it will be, by omission, a measurement relative to the 

detector’s spacing. 

- If the measurement can be calibrated or magnified, the calibrated or magnified value will be given as a priority and it will 

always be displayed together with the corresponding label that explicitly indicates its condition. 

- If the image is not of projection radiography (CT, MR, PT, US, etc.), it will be a physical measurement (mm) by omission and it will 

not be displayed together with any label. 

- If the conditions for an unknown meaning measurement are met, the measurement will always be displayed together with the 

corresponding label that explicitly indicates its condition. 

 

8.3.8.5. Measurements verbosity 

Since sometimes we can have more than one result for the same measurement, we might want to have more or less information 

depending on the case. For this reason, we can define the verbosity for the measurements that are computed. By default, the 

verbosity will be the minimal. This option can be configured in the 2D viewer configuration options. 

 

The options about the verbosity we can choose are the following: 



 

2019-07-15 

USER MANUAL 

v1.0 

68 

 

- Minimal: One single measurement will always be displayed. Only the labels for calibrated and magnified measurements will be 

displayed. This is the option set by default. 

- Minimal Explicit: The same as in the Minimal option, but also displaying labels in detector measurements. 

- Verbose: There will be as many labels as the present attributes allow. Only the labels for calibrated and magnified measurements 

will be displayed. 

- Verbose Explicit: The same as in the Verbose option, but also displaying labels in detector measurements. 

8.3.8.6. Accuracy and precision 

In simple terms, accuracy measures how close the results are to the reality, while precision measures how much they vary when 

performing repeated measures of the same thing.1 

 

In Starviewer, precision of measures is limited mainly by the precision of the user or the input device (i.e. the mouse) when trying to 

perform the same measure, and also by the image resolution. On a lower degree, it is also limited by the precision of the DICOM DS 

(Decimal String) Value Representation2, the precision of the C++ double type34 and the precision of the FPU in the specific CPU5. 

 

On the other hand, accuracy depends on the calibration of the scanning device and the image resolution. 

 

Accuracy has been verified with several measuring tests, including testing with reference images.6 

 

Numbers in Starviewer are displayed with the following precisions: 

 

- Distances, areas, statistical values and SUV are displayed rounded to 2 decimal places 

- Angles are displayed rounded to 1 decimal place 

- Window width and level values are displayed rounded to integers 

- Pixel values are displayed with as many decimal places as needed (following the default C++ behaviour) 

   

                                                                 

 
1 https://en.wikipedia.org/wiki/Accuracy_and_precision 
2 http://dicom.nema.org/medical/dicom/current/output/chtml/part05/sect_6.2.html 
3 https://en.cppreference.com/w/cpp/language/types#Floating_point_types 
4 https://en.wikipedia.org/wiki/IEEE_754 
5 https://en.wikipedia.org/wiki/Floating-point_unit 
6 http://www.dclunie.com/ 

https://en.wikipedia.org/wiki/Accuracy_and_precision
http://dicom.nema.org/medical/dicom/current/output/chtml/part05/sect_6.2.html
https://en.cppreference.com/w/cpp/language/types#Floating_point_types
https://en.wikipedia.org/wiki/IEEE_754
https://en.wikipedia.org/wiki/Floating-point_unit
http://www.dclunie.com/
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9. ADVANCED VISUALISATION 

9.1. RECONSTRUCTIONS 

 

 
 

Function: It changes the cutting plane of the images. 

 

 

Shortcut keys: CONTROL+1 (axial), CONTROL+2 (sagittal), CONTROL+3 (coronal). 

 

Mode of operation: Click on the corresponding icon, and the series contained in the active viewer will be reconstructed according to 

the chosen view (axial, sagittal or coronal). 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

 

 

 
           Axial         Sagittal          Coronal 

 

9.2. THICK SLAB 

 

(initial state)    (available options) 

 

Function: It assembles the information of a range of images in a single one. The available compositions are MIP (Maximum intensity 

projection), MinIP (Minimum intensity projection) and Average. 

 

Mode of operation: Select the viewer where the Thick Slab has to be applied (if it is not selected yet), select an option from the drop-

down menu (Disabled, MIP, MinIP, Average), and select the number of images to assemble or select the option Maximum 
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Thickness. Changes are immediately applied to the selected viewer. 

 

If the view of a viewer is changed while the Thick Slab is enabled, then the physical thickness is kept in the new view. For example, if 

we have a viewer in axial view with a MIP with a total thickness of 10 mm and we change to a sagittal view, in the new view a MIP 

will be applied with the necessary number of images so that the total thickness remains 10 mm or the closest possible. However, 

when the Maximum Thickness option is enabled, the maximum thickness accepted by the view we have changed will be applied. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

The top-left viewer contains the original image. The top-right one is the result of applying a Thick Slab with a MIP of 65 images, the 

bottom-left one is the result of applying a MinIP with a thickness of 65 images, and the bottom-right one is the result of computing the 

average also with 65 images. 
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9.3. REFERENCE LINES 

 

 
 

Function: It allows users to visualise which area of the remaining viewers corresponds to a specific cutting plane. 

 

Shortcut key to activate it: L 

 

Mode of operation: Select the reference lines icon and, from now on, for all the image changes performed to any viewer, if it is 

possible (same study, the patient has not moved...), the cutting plane in reference to the rest of viewers will be displayed. 

 

Viewer where it is applied: All the viewers that contain a series of the same patient study, where the patient has not moved. 

 

Example: 

In the first example, the leftmost viewer is the selected one, and the other viewers show a line that corresponds to the slice displayed 

in the main viewer. 

 

 
 

In the second example, the main viewer is the one on the right, and it shows how the tool works with a viewer where we have 

enabled the Thick Slab; as the viewer displays more than one image at the same time, the cutting plane has a thickness, which is 

what the viewer on the left shows. The entire area between the two parallel lines is what is displayed in the main viewer. 

 

 

 
In order for the reference lines to be displayed, the angle between the reference image planes and the projected one must 

be between 45º and 135º. 
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9.4. 3D CURSOR 

 

 

Function: It allows users to choose a point of an image, and the other viewers automatically check whether they contain the point 

and position themselves in order to show the point it corresponds to. 

Shortcut key to activate it: C 

Mode of operation: 

Select the 3D cursor icon, and select a point of an image from a viewer; the rest of the viewers, if 

possible (same study, the patient has not moved...), will show the image that contains the same point. 

The point can be changed by clicking on another point of the image, or by holding down the left button 

and moving the cursor. Images are automatically updated. 

 

Viewer where it is applied: All the viewers that contain a series of the same patient study, where the patient has not moved. 

 

Example: 

A point has been selected in one of the viewers, and the other viewers automatically show the same point. If the viewer is displaying 

a reconstruction (sagittal or coronal), it will keep on showing the point according to the reconstruction. 

 

 
 

Left button 
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9.5. VIDEO 

 

  
(when selecting the right arrow, the other options are displayed) 

 

Function: It displays the images one after the other automatically, as if it was a video. 

 

Mode of operation: Select the viewer where the video has to be displayed (if it is not selected yet) and press the 

start icon ICON 1. 

The slider allows users to control the speed at which images are displayed. 

If ICON 2 is enabled, when it is finished it starts again, so that the video is repeated continuously. 

If this option is enabled together with ICON 3, the video moves backwards instead of returning to the beginning 

when it arrives at the end. 

 

Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

9.6. VOXEL INFORMATION 

 

 
 

Function: It shows the value of a specific point (voxel). As many values as voxel components will be displayed. If 

the image is monochrome, a single value will be displayed; if the image is RGB, the values of each channel will 

be displayed. The value can be displayed together with the corresponding units depending on the modality, e.g. 

HU for Hounsfield units in CT images. 

 

Shortcut key to activate it: V 

 

Mode of operation:  

 

Mouse: Select the voxel information icon, and move the mouse over the image, and the value of the point where 

the cursor is placed is displayed. 

 

Viewer where it is applied: Viewer under the cursor. 

 

Example: 

We select the tool and we move the cursor over the image, and the value of each position is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 1 

 
 

ICON 2 

 
 

ICON 3 
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9.7. DICOM INFORMATION 

 

 
 

Function: It shows additional information contained in the DICOM file of the image displayed in the selected viewer. Users can 

consult the most relevant information, but also any other information not defined as relevant. 

 

Mode of operation: Select the viewer from which the information has to be displayed, and also the desired image. Then, press the 

additional information button and the information of the selected image is displayed in the main viewer. 

If the relevant information has been defined for the image modality, the content will be displayed in the Meaningful Tags tab. 

Otherwise, select the All Tags tab to consult all available information. 

 

 
 

From the All Tags tab, searches are allowed to filter the information, either by showing the results that match the search or by 

highlighting them. 
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Viewer where it is applied: Active viewer (with a darker or blue colour frame). 

 

Example: 

If we want to consult the content of the SpacingBetweenImages tag of a magnetic resonance study, we select the DICOM 

information tool and the relevant tags are displayed. 

 

 
 

Since the tag we are looking for is not relevant, we select the All Tags tab, and we perform a search by introducing the text spacing; 

all the tags that contain this text are displayed. 
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9.8. MANUAL SYNCHRONISATION 

 

   
 

The icon is placed at the bottom-right corner of each viewer: 

 

 
 

Function: Each image change (spatial jump) that is performed in a viewer has an effect to the rest of viewers when the 

synchronisation tool is enabled. To perform the jump, the distance travelled is considered instead of the amount of images. 

 

Mode of operation: Press the synchronisation button of all the viewers that have to be synchronised (at least 2 viewers). From this 

point, each movement made when changing an image will have an effect to the rest of synchronised viewers as long as they display 

the same view, that is, if we make a movement in a viewer displaying an axial view, only the viewers with the manual 

synchronisation enabled that display an axial view will be automatically changed. The chain icon indicates whether the viewer in 

manually synchronised (closed) or not (opened). 

This tool considers the distance travelled and not the amount of images, so that there is always the same jump with different 

viewers. 

Enabling the manual synchronisation disables the automatic synchronisation. See the section Automatic synchronisation. 

 

Viewer where it is applied: All the viewers selected with the synchronisation button. 

 

9.9. MANUAL SYNCHRONISATION IN ALL VIEWERS 

 

 
 

Function: It activates the manual synchronisation to all viewers at the same time. See tool Manual synchronisation. 

 

Shortcut key to activate it: U 

 

Mode of operation: Press the Activate manual synchronisation in all viewers button. From this point, the behaviour is the same as if 

the manual synchronisation would have been selected in each viewer. See section Manual synchronisation. 

 

Viewer where it is applied: All viewers that contain a loaded image. 
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9.10. DEACTIVATING MANUAL SYNCHRONISATION IN ALL VIEWERS 

 

 

 

Function: It disables the manual synchronisation to all viewers at the same time. See tool Manual synchronisation. 

 

Shortcut key to activate it: SHIFT+U 

 

Mode of operation: Press the Deactivate manual synchronisation in all viewers button. From this point, the behaviour is the same as 

if manual synchronisation would have been disabled in each viewer. See section Manual synchronisation. 

 

Viewer where it is applied: All viewers that contain a loaded image. 

9.11. AUTOMATIC SYNCHRONISATION 

 

 
Auto-Sync 

 

Function: It automatically synchronises all the viewers, placing them at the same position when activating the tool, and causing each 

jump made in a viewer to have an effect to the rest of viewers (as long as it is possible: same study, the patient has not moved...). 

 

Shortcut key to activate it: O 

 

Mode of operation: Press the automatic synchronisation button. From this point, each movement made when changing an image will 

have an effect to the rest of viewers automatically, as long as it is possible: same patient and study, the patient has not moved... 

This tool takes into account the image acquisition plane; therefore, changes in axial view will only have an effect to the viewers in 

axial view. The same is applied for sagittal and coronal views. 

Enabling the automatic synchronisation disables the manual synchronisation. See section Manual synchronisation. 

 

Viewer where it is applied: All. 

9.12. PROPAGATION 

 
Propagate 

 

Function: It propagates a set of visualisation properties of the active viewer, so that these properties can be synchronised with the 

viewers that have a series of common attributes with it. These attributes may vary depending on property modified in the active 

viewer. 

 

Shortcut key to activate it: P 
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Mode of operation: Propagation can be manually activated or deactivated through the toolbar button or the shortcut key P. When it is 

activated, an initial propagation of the properties is made between all the viewers, where the active viewer in that moment has 

priority, so that they are synchronised from the beginning. 

 

Below, the properties that can be synchronised and the conditions that have to be met in each case for the synchronisation to be 

effective are detailed. 

 

- Window: the window of the active viewer is propagated. If we select a default window (the ones included in the DICOM heading, 

the standard and the automatic ones), the equivalent window corresponding to the image they are displaying is selected in the other 

viewers. For default windows, the absolute window values are propagated. 

Synchronised viewers: those that contain the same series as the active viewer. For fused models, it will only be applied on the 

matching series. 

 

- Zooming: the zooming absolute value from the active viewer is propagated. 

Synchronised viewers: those that have the same anatomical plane and modality as the active viewer. Exception: if modalities are 

PET-CT or SPECT-CT and they have the same anatomical plane, there is synchronisation as well. 

 

- Scrolling: the position of the image within the active viewer is propagated if the series between viewers share the same coordinate 

system (that is, they are from the same study, the patient has not moved, etc.). If the coordinate system is different, it cannot be 

guaranteed that the same position is displayed between viewers; therefore, propagation of scrolling is not allowed. 

Synchronised viewers: those that have the same anatomical plane as the active viewer and share a coordinate system. 

 

- Orientation: the orientation (rotation and flipping) of the image from the active viewer is propagated. 

Synchronised viewers: those that have the same anatomical plane and modality as the active viewer. Exception: if modalities are 

PET-CT or SPECT-CT and they have the same anatomical plane, there is synchronisation as well. 

 

- Phase: the phase of the active viewer is propagated. 

Synchronised viewers: those that have fused series. It is only applied on the secondary series as long as it is the same as the one 

from the active viewer. 

 

- Thick slab: the projection type and the thickness of the thick slab of the active viewer are propagated. 

Synchronised viewers: those that have fused series and the same anatomical plane as the active viewer. It is only applied on the 

secondary series as long as it is the same as the one from the active viewer. 

 

Others: Propagation can be automatically activated for certain modalities. With the default configuration the propagation is activated 

for the CT, MR and PET modalities. To learn how to configure the default modalities, see section 2D viewer configuration. In 

addition, we can also choose which properties are propagated and which are not. If we display the menu attached to the propagation 

icon, we will see the list of active properties. By clicking on these, we will activate or deactivate them. By default, all available 

properties are propagated. The selection of properties applies to all the modalities equally. 

 

 

 

 

 

Examples: 
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Window 

We have the following viewers layout, where all the viewers have the same series: 

 
 

If we change the window in the viewer with coronal view using the window tool the window values are propagated to the other 

viewers. 

 

 
 

 

Zooming, scrolling and orientation 
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We have the following viewers layout: 

 

 
 

If we zoom in the axial viewer on the left, the action is absolutely propagated to the axial viewer on the right, so that the same object 

looks the same size in both viewers. 

 

 
 

 

If we scroll the image in the axial viewer on the right, the new position is propagated to the axial viewer on the left, so that the same 
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object is displayed in the same position in both viewers if they share the same coordinate system; if they have different coordinate 

systems there will be no propagation. 

 

 
 

If we rotate the image in the axial viewer on the left, the same orientation is propagated to the axial viewer on the right. 

 

 
 

 

If we vertically flip the image in the axial viewer on the left, the same flipping is propagated to the axial viewer on the right. 
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Thick slab 

We have the following viewers layout: 

 

 
 

 

 

If we activate the thick slab with a MIP projection and we increase the thickness in the axial viewer with a PET series, it is 

propagated to the axial viewer with fusion applying the same projection and thickness to the secondary image (PET), but not to the 
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primary one (CT). 

 

 
 

If we change the projection type to MinIP in the axial viewer with the PET series, it is propagated to the axial viewer with fusion by 

changing the projection of the secondary image (PET) to MinIP. 
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9.13. FUSION 

The fusion function allows users to display a fused visualisation of PET-CT or SPECT-CT. A fusion can be loaded from the same 

patient studies menu, where all the possible fusion combinations are shown after the individual series. For a CT series to be fused 

with PET or SPECT one, the following conditions must be met: 

 

- Both series have to share the same spatial identifier (Frame of Reference UID), that is, they are acquired in the same coordinate 

system. 

- The CT series has to be contained in the space occupied by the PET or SPECT series, or vice versa. 

 

In a PET-CT or SPECT-CT fusion, the CT series is seen as the main series over which the PET or SPECT series is superimposed 

as the secondary one, partially transparent and with a colour function. Both series are permanently synchronised to show the same 

region of space. If an area only available in the CT is explored, the PET or SPECT will not be displayed. 

The contribution of each series to the final fused image is, by default, 50% of each series, but it can be adjusted through the Fusion 

balance tool, which is displayed at the bottom of the viewer, next to the manual synchronisation button. The current balance can be 

seen at all times in the lower-right corner of the viewer. 

 

Some tools behave differently when a PET-CT or SPECT-CT fusion is displayed or when a single series is displayed: 

 

- The selection of a colour function changes the colour of the PET or SPECT series instead of that of the main series. 

- The voxel information tool displays two values, one of each series. For the PET image, the SUV value will be displayed whenever 

possible. 

- The ROI tools, in addition to the corresponding values of ROI of the CT image, show the maximum and average value of SUV, 

computed according to the selected method in the Starviewer configuration. 

 

On the other hand, there are certain functionalities and tools that are not synchronised between the CT and PET or SPECT fused 

images, and must be applied separately. When we interact on the viewer with fusion, the change of window, the change of phase 

and the thick slab function are only applied to the main series, that is, the CT one. To interact on the secondary series, the PET or 

SPECT one, we need the propagation through a secondary viewer. We must have the PET or SPECT series loaded in another 

viewer; then, through this viewer and enabling the propagation, we can synchronise and change the phase, the window or the thick 

slab of the fused PET or SPECT series. 

 

ACTION TO APPLY ON CT IMAGE (FUSION) TO APPLY ON PET IMAGE (FUSION) 

Change of window 

Change of phase 

Thick Slab 

Apply the action on the viewer with fusion Apply the action on the secondary viewer with the 

same PET or SPECT series as the viewer with 

fusion. Propagation must be enabled. 

Colour function Not applicable Select the colour function on the viewer with 

fusion 

 

 

 

 

 



 

2019-07-15 

USER MANUAL 

v1.0 

85 

Finally, the other functionalities and tools do not depend on the content of the image, so that they behave exactly the same as with a 

simple visualisation. 

 

Example: 

In the following image we see an example of a PET-CT fusion where, from left to right, we have the fused image, the CT image and 

the PT image. At the top we see the axial projection, and at the bottom the coronal projection of the same series. 

 

9.13.1. Fusion layout 

 

 
 

A custom fusion layout can be created by applying a regular layout and then assigning the desired series to each viewer, or by 

applying one of the default fusion layouts. In the viewers that visualise a fusion, a button is displayed in the lower-right corner that 

allows users to apply a fusion layout of 2x1, 3x1, 2x3 or 3x3 that replaces the current layout of the window. 

 

 
 

 

 

 

Example: 
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1. We load a fusion into a viewer: 

 

 
 

2. We apply a fusion layout: 

 

 
 

3. Result: 
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9.14. FUSION BALANCE 

 

   
 

The icon is placed in the lower-right corner of each viewer: 

 

 
 

Function: It controls the percentage of fusion that each image contributes with to the final fused image. This allows us to see only the 

primary or secondary image (balance 100%-0% or 0%-100%, respectively), or that the contribution of one of the two images is 

greater with respect to the final image. By default, both fused images are balanced at 50%. 

 

Mode of operation: Press the fusion balance button in a viewer with fused images. A slider will be displayed where we can balance 

the fusion percentage of each image. This button will only be displayed in viewers that have fused images. 

 

Viewer where it is applied: In the selected viewer with fusion. 

 

Example:  

In the following example we see an example of how the slider is displayed, and of the annotations of the viewers that indicate at all 

times the current fusion balance of each image. 
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9.15. STANDARDISED UPTAKE VALUE (SUV) MEASUREMENT 

 

The SUV is a value commonly used in the PET modality image analysis. It is commonly defined as the relationship of the radioactive 

concentration C of the tissue (Bq/ml) in instant t, and the injected activity, multiplied by a normalisation factor, such as the body 

weight. 

 

The SUV is computed when we draw a ROI on a PET image or a fused PET-CT image. The SUV will be computed over the 

maximum and the average value of the drawn ROI with respect only to the values of the PET image, whether it is fused or not. There 

are three normalisation methods: 

- Body weight 

- Lean body mass 

- Body surface area 

 

The selection of which normalisation method is used can be configured in the 2D viewer configuration options. The method used by 

default will be that of body weight. 

 

In the annotation of the measurement, a label will indicate the applied normalisation method: 

- bw: Body weight 

- lbm: Lean body mass 

- bsa: Body surface area 

 

Each measurement (maximum and average value) will be displayed together with the corresponding units, which may be the 

following according to the normalisation method: 

- g/ml: For weight and lean body mass 

- cm2/ml: For body surface area 

9.15.1. Formulae 

In this section we detail the formulae used, as well as the required parameters for is computation. 

9.15.1.1. SUV 

𝑆𝑈𝑉 =  
𝐶(𝑡)

𝐷𝑖 × 𝑑
× 𝑁 

 

PARAMETER DESCRIPTION UNIT 

C(t) Radioactive concentration Bq/ml 

Di Injected radioactive dose Bq 

d Decay correction factor  

N Normalisation factor chosen (weight, lean 

body mass or body surface area) 

g: Weight and lean body mass 

cm2: Body surface area 

9.15.1.2. Decay correction factor 

The injected dose Di to compute the SUV is corrected by the radioactive decay factor between the injection time and the beginning 
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of the acquisition through the formula[1]  

𝐷𝑒𝑐𝑎𝑦 𝑓𝑎𝑐𝑡𝑜𝑟 =  2
(

−∆𝑡

𝑇1
2⁄

)

 

Where:  

T1/2: Half-life in seconds 

The computation of Δt depends on the value of the Decay Correction (0054, 1102) DICOM attribute: 

- If it is START: Δt will be the time interval between the administration of the dose and the acquisition of the image, in seconds 

- If it is ADMIN: Δt will be 0 

 

 
The computation of the time interval will preferably be done with the Series Date (0008, 0021), Series Time (0008, 0031) and 

Radiopharmaceutical Start Date Time (0018, 1078) attributes. If they are not available, it would be done with the Series Time 

(0008, 0031) and Radiopharmaceutical Start Time (0018, 1072) attributes assuming that the administration and the 

acquisition of images are done the same day. If any of these attributes is missing, the computation of the SUV cannot be 

carried out. 

9.15.1.3. Lean body mass 

The lean body mass is computed with two formulae, Morgan’s[2] or James’[3], depending on the patient sex: 

 

Men (Morgan) 

1.1 × 𝑊 − 120 × (
𝑊

𝐻
)

2

 

Women (James) 

1.07 × 𝑊 − 148 × (
𝑊

𝐻
)

2

 

Where: 

W: Weight of the patient in kg. 

H: Height of the patient in cm. 

9.15.1.4. Body surface area 

To obtain this value we use the formula from Du Bois[4]  

𝐵𝑆𝐴𝑐𝑚2 = 71.84 × 𝐻0.725 × 𝑊0.425 

Where: 

W: Weight of the patient in kg. 

H: Height of the patient in cm. 

9.15.1.5. Bibliographical sources 

[1] “Radioactivitat.” Wikipedia: The Free Encyclopedia. Wikimedia Foundation, Inc., December 8, 2013. Web. January 21, 2014. 

<http://ca.wikipedia.org/wiki/Radioactivitat#Llei_fonamental_de_la_desintegraci.C3.B3_radioactiva)> 

[2] Morgan, Denis J. and Bray, Kelly M. Lean Body Mass as a Predictor of Drug Dosage: Implications for Drug Therapy. Clinical 

Pharmacokinetics. 1994, Vol. 26, 4, pp. 292-307. 

[3] James, W. Philip T. Research on obesity. London: Her Majesty's Stationery Office, 1976. ISBN 0114500347. 

[4] Du Bois, Delafield and Du Bois, Eugene F. A formula to estimate the approximate surface area if height and weight be known. 

Archives of Internal Medicine. 1916, Vol. 17, 6-2, pp. 863-871. 

http://ca.wikipedia.org/wiki/Radioactivitat#Llei_fonamental_de_la_desintegraci.C3.B3_radioactiva
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9.15.2. Required data 

The following list presents the required DICOM attributes to compute the SUV. The lack of any of these attributes may cause the 

SUV value or some type of normalisation cannot be computed. 

 

ATTRIBUTE DESCRIPTION NEEDED FOR 

(0010,1030) Patient’s weight Any SUV (bw, lbm, bsa) 

(0010,1020) Patient’s height lbm, bsa 

(0010,1040) Patient’s sex lbm 

(0008,0021) Series date Decay correction factor 

(0008,0031) Series time Decay correction factor 

(0018,0078) Date and time of dose administration Decay correction factor 

(0018,0072) Time of dose administration Decay correction factor 

(0018,0075) Half-life Decay correction factor 

(0018,0074) Radioactive dose administered to the patient at the 

moment of administration 

Injected radioactive dose 

(0054,1001) Units of pixel values SUV. Depending on the units it will determine 

whether it can be computed or not. 

 

9.15.2.1. Manufacturer exclusive attributes 

Depending on the manufacturer of the modality we will need to use additional private attributes to compute the SUV. 

 

MANUFACTURER ATTRIBUTE DESCRIPTION NEEDED FOR 

Philips (7053,1009) Pixel conversion factor Converting pixel values to Bq/ml 

 

9.16. MPR 2D VIEWER 

The MPR 2D viewer allows users to perform reconstructions of a series in any cutting plane, whether it is orthogonal or not. 

 

It allows users to manipulate two additional cutting planes that form the resulting images, thus seeing images in acquisition planes 

that are different from those acquired by the modality. 

 

To move the cutting planes, follow the instructions below: 

 

OPTIONS DESCRIPTION 

Rotation The cursor is placed on one of the lines and, while holding down the left button of the mouse, the 
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mouse is moved in the direction where the cutting plane has to be rotated. 

Movement The cursor is placed on one of the lines and, while holding down the CONTROL key and the left 

button of the mouse, the mouse is moved in the direction where the cutting plane has to be moved. 

 

 

 
 

The two spheres placed on the two lines indicate the rotation centre of the cutting planes.  
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It also has different computation tools: 

- Distances, TA-GT 

- Angles 

- Open angles 

- Elliptic ROI, Polygonal ROI, Magic ROI, Circle (Regions of interest) to compute areas and average grey values 

- Erasing performed measurements 

 

And other tools: 

- Scrolling 

- Zooming 

- Magnifying glass 

- Erasing annotations 

- Save a screenshot in image format (.jpg, .png, .bmp) 

- Exporting to PACS 

- Removing patient's information from the viewer 

- Visualise the information of a single voxel (position, value) 
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9.17. 3D VIEWER 

It visualises all the information of the volume in 3D (volume rendering), with the option of adding or removing information or applying 

different colour functions (transfer function). 

 

The defined transfer functions are the following ones: 

 

 
 

To apply one of the previous functions, users just need to double-click on the corresponding image with the mouse. 

 

 
 

It has different tools: 

- Visualising the volume from the axial, sagittal or coronal view 

- Zooming 

- 3D rotation 

- Changing the window 

- Panning 

- Trimming a volume (cutting planes) 
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- Screenshot 

- Sending image to PACS 

 

9.18. CUTTING PLANES 

 
 

Function: It allows users to trim a volume within a 3D viewer to remove areas of the volume that users do 

not want to visualise. These areas are simply hidden, and the information is never deleted permanently. 

 

Shortcut key to activate it: B 

 

Mode of operation: It consists in a box that includes the volume. All the information that remains inside 

the box will be visible, and what remains outside will be trimmed, so that it will be non-visible information. 

The trimmed information is not lost, it simply remains hidden. Users can unhide it by modifying the size of 

the box so that it does not hide any part of the volume. 

 

There are different actions that can be performed with this cutting box, which are explained below. To 

manipulate the different faces users have to use the spheres drawn on each face (6 faces – 6 spheres). 

Furthermore, there is a central sphere used to manipulate the whole box at the same time. 

 
 

Cropping on one face: Hold down the LEFT BUTTON of the mouse on one of the spheres that are 

displayed when selecting the cutting planes tool, and move the mouse in the direction where the 

information has to be removed. Cuts can be made on each side of the white-framed box that is displayed 

around the whole volume. 

 
 

Increasing/Reducing the cutting box: Hold down the RIGHT BUTTON of the mouse inside the box that 

includes the volume and move the mouse up (if increasing) or down (if reducing). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LEFT BUTTON 

 
 

 

 

 

 

 

RIGHT BUTTON 
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Moving the cutting box: Hold down the MIDDLE BUTTON of the mouse inside the box that includes the 

volume and move the mouse in the direction where the box has to be moved. This operation can also be 

done by selecting the central sphere of the container box. 

 

 
 

Rotating the cutting box: Hold down the LEFT BUTTON of the mouse on one of the faces (without 

selecting any sphere) that are displayed when selecting the cutting planes tool, and move the mouse in 

the direction where the box has to be rotated. 

 
 

If we deactivate the cutting planes tool we will see the trimmed volume. To display all the information of 

the volume, we need to activate the tool again to display the box and increase it until we see the initial 

information. 

 

Viewer where it is applied: 3D viewer. 

 

Example: 

The volume on the left shows the initial state, once the tool has been activated. Three of the spheres that 

belong to each face where the volume can be trimmed are displayed. 

The volume in the middle shows the action of trimming one of the faces (the one that contains the red 

sphere). 

The volume on the right shows the final state, after trimming one of the faces, and also after deactivating 

the cutting planes tool, thus hiding the box that includes the volume. 

 

 

 

 

 

 

 

 

 

MIDDLE 

BUTTON 

 
 

 

 

 

 

 

 

LEFT BUTTON 
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9.19. 3D ROTATION 

 

 
 

Function: It allows users to rotate a volume within a 3D viewer to visualise it from different points of view. 

 

Shortcut key to activate it: Q 

 

Mode of operation: 

 

Mouse: Hold down the right button of the mouse while moving the mouse in the direction where 

the volume has to be rotated. 

To rotate the axis perpendicular to the image, press the CONTROL key while rotating with the 

mouse. 

 

Viewer where it is applied: 3D viewer. 

 

Example: 

The volume on the left would be the initial position, and with a rotation we can see it from the point of view displayed in the volume 

on the right. 

 

9.20. EXTERNAL APPLICATIONS 

If external applications have been defined in the Starviewer configuration, these will be displayed in the Tools > External applications 

 

Click the right button 

and move the mouse 
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menu. For more information, check the section for the external applications configuration. When clicking on it, it is possible that some 

information (if this is how it has been configured) is transmitted from the active viewer to this application. In this way, the application 

that is opened can know the current working context and act properly (for example, by showing the same study opened in 

Starviewer). 
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10. DIAGNOSIS TESTS 

To access the diagnosis tests, users have to open the Tools > Run Diagnosis Tests menu. 

Its functionality is to verify a series of system parameters and run a series of tests that allow users to evaluate whether the system is 

well configured and fulfils the recommended requirements, and to diagnose errors and possible problems. 

 

When selecting the menu, a window is opened that indicates that the tests are running, where the percentage of tests executed so 

far is displayed. 

 

 
 

Once the test is completed, two types of messages may be displayed reporting the results. 

 

 
 

If no test fails, a message is displayed indicating that all tests have worked correctly. We have the option to see which tests have 

been executed with the See results button, and also the option to save the results through the Save Results button. Press OK to 

close the window. 

 

 
 

If, on the contrary, a test fails, a window is displayed with information of the system, reporting the errors found, warnings to be taken 

into account, and tests that have worked correctly. By default, the errors and warnings are displayed. To see also those that have 

worked correctly, users must select the succeeded button; to hide them, use the same procedure. 

 

By selecting ICON 1, the system information is displayed. 
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Each of the rest of messages corresponds to a specific type: Succeeded, Error or Warning. 

 

The correct results, represented with ICON 2, simply indicate that it has been executed correctly and that the 

results are the expected ones. 

 

The warnings, represented with ICON 3, indicate that something is not well configured or that the application may 

not work as expected, but users can still use it. It is recommended that no warning message is displayed. 

 

If there is an error, it is indicated with ICON 4. If we get an error, it may be that the test could not be executed or 

that the result of the test is incorrect. 

 

If the result is an error or a warning, we can open it to see the detailed description of the problem by clicking on the 

header of the problem. It also allows us to see a solution to solve the problem and, therefore, to have the 

application well configured. 

 

Finally, at the bottom-left corner of the window, we have the option Save Results, which allows us to save the 

results in a text file and send them by email as an attached document to support@starviewer.udg.edu in order to 

get support for solving the problem. 

By pressing the OK button, the window is closed. 

  

 

ICON 1 

 
 

 

ICON 2 

 
 

ICON 3 

 
 

ICON 4 
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11. DICOM PRINTING 

Extension that allows users to print images in DICOM format in DICOM printers. 

To print an image, users have to open the Visualization menu and choose the option DICOM Print. 

 

 

 

In this window, the printing preferences are displayed on the left, and the image to be printed on the right. The 

viewer allows users to change the image, the series and the patient study by using the patient menu (right button). 

It also allows users to change the window of the images to be printed by using the Changing the window tool and 

the Selection of default windows tool. If we want to restore the image to the initial image, we have to press the 

restoration button (ICON 1). 

 

The panel on the left allows users to choose different parameters such as: 

- Printer (see section Adding a printer for more information) 

- Number of copies 

- Film size 

- Film type 

- Orientation 

- Printing grid size 

- Images to be printed: current, or range of images (see section Selecting images to print for more information) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 1 
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11.1. SELECTING IMAGES TO PRINT 

 

With the printing tool users can print more than one image from different series of the same film. To select the images to be printed, 

the following steps will be followed as many times as necessary until all images in the printing list are obtained: 

 

1. Select the series that contains the images in the viewer on the right. 

2. Select the images to be printed through the section Images to print. 

Images can be selected in different ways: 

- Current Image: It adds only the current image to the list of images to be printed. 

- Selection: It selects the images to be printed according to the chosen criteria (see example below): 

- Interval: Image leap (e.g. Printing 1 image out of 7). 

- From: Initial image of the selection to be added to the list. 

- To: Final image of the list to be added to the list. 

3. Select Add to print. 

 

Finally, once the list of images is created, select the Print option. 

 

If any of the images added to the list has to be removed, select the element of the list (image) and click Remove selection. It is also 

possible to remove all of them by selecting the Clear option. 

 

Example about how to select images: 

 
 

In this example we have decided to print the current image, which corresponds to image 24, we have also decided to print all the 

images from the series, and finally we have added to the printing list images from 1 to 14 with a leap of 7 images, so that images 1 

and 8 are added to the list. Total number of films that will be printed: 4, since we have chosen that there are 12 images for each film. 

 

11.2. ADDING A PRINTER 
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To add a printer, users have to select ICON 1 from the DICOM Print extension, and the following window is 

displayed: 

 

 
 

Different actions can be carried out: 

- Add New Printer: Click ICON 2 to add a new printer. 

 

 
 

OPTIONS DESCRIPTION 

AE Title Name of the printer 

Hostname IP address of the printer 

Port Connection port with the printer 

Description Short description of the printer 

Default printer Whether it is or not the printer configured by default (only one printer can be 

configured by default) 

- Remove Printer: To remove a printer from the list click ICON 1. 

 

 

ICON 1 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICON 2 
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ICON 2 
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- Test Printer: Click ICON 2 to check the connection with the printer. If the test fails, it may be that the printer is not available, or that 

some of the configuration parameters such as the AE Title or the port are incorrect. 

 

 
To make an advanced printer configuration, check the administrator’s manual of the application. 
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12. THE MENUS 

From the menu bar, we find different options: 

- File menu 

- Visualisation menu 

- Tools menu 

- Window menu 

- Help menu 
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12.1. FILE MENU 

 

Menu from where users can manage the data sources to be consulted and perform a basic management of the application. 

 

 
 

 

OPTIONS DESCRIPTION 

New Window It allows users to open a new instance of Starviewer. 

Shortcut keys: CONTROL+N 

Local Database Studies... It allows users to access and open studies that been retrieved to the local database (to the 

computer).  

Shortcut keys: CONTROL+L 

PACS... It allows users to access a PACS, retrieve and visualise studies. 

Shortcut keys: CONTROL+P 

Open DICOMDIR... It allows users to open files from patients that are stored in another place (user’s folder, CD, 

DVD, external drive, USB...). 

Shortcut keys: CONTROL+D 

Open Files... It allows users to open studies that are not in DICOM format, such as an MHD... 

Shortcut keys: CONTROL+O 

Open Files from a Directory... It opens all files that are in the same folder.  

Shortcut keys: CONTROL+SHIFT+D 

Close It closes the current tab. 

Shortcut keys: CONTROL+W 

Exit It closes the application. 

Shortcut keys: CONTROL+Q 

 

 

 

12.2. VISUALISATION MENU 

Once a study has been opened, different viewer types to display the patient’s studies can be chosen, or extensions to use different 



 

2019-07-15 

USER MANUAL 

v1.0 

106 

resources: 

 

- 2D Viewer (by default when a study is chosen) 

- MPR 2D Viewer 

- 3D Viewer 

- DICOM Print 

 

 
 

To choose one of the viewers, users only need to select the element within the Visualisation menu. A new tab is displayed with the 

new selected viewer. 
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12.3. TOOLS MENU 

From the Tools menu users can select the language, and also access to different configurations such as PACS, Database, etc. 

 

 

 
 

From the Language option there are three possibilities: Catalan, English or Spanish. Each time the language is changed, the 

application must be restarted in order for the changes to take effect. 

 

From the Configuration menu different elements can be configured: 

- 2D Viewer 

- 2D Viewer Layout 

- PACS 

- Local Database 

- RIS Listener 

- DICOMDIR 

 

Finally, the tools menu contains a tool to verify the state of the system to check that the application works correctly. See section 

Diagnosis tests. 
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12.4. WINDOW MENU 

The Window menu allows users to choose four options as shown in the following image: 

 

 
 

Below we detail each of these functions. 

12.4.1. Move to screen 

It allows users to move the window of the application to a specific screen. The menu shows the current screen configuration and, by 

selecting the desired screen, the application is placed on it. 

 

 
 

12.4.2. Maximise to multiple screens 

 

Shortcut: CONTROL+SHIFT+M 

 

The application window is maximised to occupy the maximum number of screens as long as the rectangular shape of the window 

can be maintained. The horizontal expansion is first considered, and then the vertical expansion. 

 

 

 

 

 

 

 

 

 

In the previous drawing the application window and the screen where it is located are displayed in black, while the rest of screens 

are displayed in blue. If we maximise, it is horizontally expanded as much as possible. 

 

In the following drawing, the application window and the screen where it is located are also displayed in black, and the same for the 

rest of the screens, which are displayed in blue. In this case, if we maximise it is vertically expanded as much as possible, but it is 
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also horizontally expanded to the maximum. 

 

 

 

 

 

 

 

12.4.3. Move to adjacent screen 

With the Move to previous screen and Move to next screen options we can move the window to the previous and next screens in a 

sequential and circular way, as it is shown in the following drawing. 

 

 

 

 

 

 

 

 

 

12.4.3.1. Move to previous screen 

Shortcut:  CONTROL+SHIFT+ 

When it reaches the leftmost screen, if there are no more screens, it is placed to the rightmost screen that is below the current one. If 

there are no more screens below, it is placed to the topmost and rightmost screen. 

12.4.3.2. Move to next screen 

Shortcut: CONTROL+SHIFT+ 

When it reaches the rightmost screen, if there are no more screens, it is placed to the leftmost screen that is below the current one. If 

there are no more screens below, it is placed to the topmost and leftmost screen. 
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12.5. HELP MENU 

From the Help, we can access this user manual, a quick start guide of the application, the shortcuts guide and the log file of the 

application (it shows different information related to the activity of the application, and also whether an error has been detected). 

 

It also allows us to check general information of the application, such as the platform version. 

 

 
 

To show this user manual, select the User Guide option. A .pdf file is opened. 

 

To show a quick start guide of the application, select the Quick Start Guide option. A .pdf file is opened. 

 

To show the shortcuts guide, select the Shortcuts Guide option. A .pdf file is opened with a diagram of the shortcuts. This diagram 

can also be found in this manual in the section Shortcuts. 

 

To show the log file, select the Show Log File option, and a window is displayed with a list of information that the application has 

been saving. 

 

Updates, improvements, corrections... of the current version can be checked with the Release Notes option. 

 

To show general information of the platform, choose the About option. It shows the version of the application, the support and 

contact address, the web page... 
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13. CONFIGURATIONS 

13.1. 2D VIEWER CONFIGURATION 

To access the 2D viewer configuration, users have to access the Tools > Configuration menu and select the 2D 

Viewer ICON 1. 

 

The 2D viewer configuration window is displayed: 

 

 
 

Different parameters can be configured: 

 

OPTIONS DESCRIPTION 

Enable slice scroll loop It modifies the behaviour of the Scrolling tool so that the images scrolling 

is continuous in both directions. From the last image we can advance to 

the first one, and from the first one we can go backwards to the last one. 

This option is disabled by default. 

Enable phase scroll loop It modifies the behaviour of the Scrolling tool so that the scrolling 

between phases is continuous in both directions. From the last phase 

we can advance to the first one, and from the first one we can go 

backwards to the last one. 

This option is disabled by default. 

Enable reference lines by default for 

these modalities 

It configures the Reference lines tool to be enabled by default when 

opening studies of the selected modalities: MR and/or CT. It is enabled 

by default for the MR modality. 

Enable automatic synchronisation by 

default for these modalities 

It configures the Automatic synchronisation tool to be enabled by default 

when opening studies of the selected modalities: MR and/or CT. It is 

 

 

 

 

ICON 1 
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enabled by default for the MR modality. 

Enable zoom by default for these 

modalities 

It configures the Zooming tool to be enabled by default in the left button 

of the mouse when opening studies of the selected modalities. 

For the modalities that are not selected, the tool assigned to left button 

will be the Scrolling. By default, the following modalities are assigned: 

CR, DX, MG, MR and RF. 

Enable propagation by default on 

these modalities 

It configures the Propagation tool to be enabled by default when opening 

studies of the selected modalities. 

By default, the following modalities are assigned: CT, MR and PT. 

Magnifying glass tool zoom factor It allows users to choose which is the zoom factor of the image when the 

Magnifying glass tool is being used. 

Measurements description verbosity It allows users to choose the verbosity for measurements that may give 

more than one result according to the present image attributes. For more 

details, see section Measurements verbosity. By default, the verbosity 

will be Minimal. 

Preferred SUV measurement 

normalisation type 

It allows users to choose the normalisation factor used in SUV 

measurements. By default it will be Body weight. For more details about 

the SUV measurements, see section Standardised Uptake Value (SUV) 

measurement. 

 

13.2. 2D VIEWERS LAYOUT CONFIGURATION 
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From this configuration section we can configure the studies layout options. Each study modality can be configured independently 

and their options are found in the corresponding tab. The parameters we can configure for each modality are the following: 

 

OPTIONS DESCRIPTION 

Apply Hanging Protocols as 

preferential layout option 

With this option selected, if there are Hanging Protocols available for the 

study of the indicated modality, the best possible Hanging Protocol will 

be applied as preferential option when loading a study. If there are no 

candidate Hanging Protocols, the layout criteria indicated in the lower 

box will be applied (Layout according to these parameters when no 

Hanging Protocol is applied). By default, the modalities in which the 

application of Hanging Protocols will be preferential are CR, CT, MG, 

MR and US. 

Layout according to these 

parameters when no Hanging 

Protocol is applied 

In this box we can define the parameters of the automatic layout for the 

selected modality. 

Layout by It configures whether the assignment sequence in each viewer is made 

by series or by images. 

Layout direction It configures the direction in which the series or the images will be 

assigned in each viewer within the layout. 

Exclude from layout It configures which images and/or series of the study are excluded in the 

assignment. Useful for not showing images or series that are not 

relevant. 

Maximum number of viewers Maximum number of viewers that will be created in the layout, 

regardless of the total number of images or series. It allows us to set a 

number between 2 and 48 viewers, or the possibility to create as many 

viewers as possible (up to a maximum of 48), adapting to the content of 

the study. 

Restore defaults It restores the default values of the selected modality. 

 

13.3. PACS CONFIGURATION 

Within the configuration of a PACS we find two tabs: PACS Servers and Local Configuration: 

13.3.1. PACS servers 

The configuration of the PACS servers allows us to add, delete and test the different PACS queried by the application. 
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OPTIONS DESCRIPTION 

Add a server Fill the fields AE Title, Address (IP), Ports, Institution, Location, Description... and press the 

Add as New PACS button. If the Default Query PACS is selected, the PACS selected with 

this option will always be queried when performing any search. 

Delete a server Select an element of the list and select the Delete option. 

Update a server Select an element of the list, change the fields to be updated: AE Title, Address (IP), Ports, 

Institution, Location, Description... and press the Update PACS button. 

Test a server Select an element of the list of PACS, and select the Test option. 

13.3.2. Local Configuration 

It allows users to configure the machine parameters required for the communication with the different PACS servers. 

 

 
 

 

OPTIONS DESCRIPTION 
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Local machine AE Title AE Title that the machine must have. 

Incoming connections port Communication port of the machine for DICOM incoming connections. 

Maximum seconds for timeout Maximum waiting time for PACS responses. 

Maximum simultaneous connections Maximum number of connections that may exist at the same time, either by 

making a query or by saving a study in the PACS. We can only have a single 

simultaneous retrieval. 

Institution contact information It allows users to add information about the institution. This institution information 

will be displayed in the readme.txt file in the DICOMDIR that are created. 
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13.4. LOCAL DATABASE CONFIGURATION 

To access the local database configuration, users have to open the Tools > Configuration menu and select the 

local database ICON 1. 

 

The local database configuration window is displayed: 

 

 
 

Different parameters can be configured: 

OPTIONS DESCRIPTION 

Database location File where the local database is stored. 

DICOM files cache location Directory where the images of the local database studies are stored. 

Minimum space required in hard disk 

to retrieve DICOM objects 

It allows users to define the minimum space necessary for the system to 

retrieve DICOM objects; if there is not enough free space the application 

does not allow users to retrieve studies. (See table footnote) 

Automatically delete studies not 

viewed in the last X days 

Each time Starviewer is opened, it deletes the studies that have not 

been visualised during the last indicated days to free disk space 

automatically. 

When there is not enough free space 

to retrieve or import new studies, 

delete old studies until XGB of free 

space are obtained 

When the minimum space in hard disk to retrieve DICOM objects is 

smaller than the one indicated, the studies that have not been visualised 

for a longer time will be automatically deleted until XGB of free space in 

hard disk are reached. 

 

 
If when new studies are imported or retrieved to the system there is less free space than the one 

indicated by the Minimum space required in hard disk to retrieve DICOM objects parameter, the 

application deletes the studies that have not been visualised for a longer time until the XGB indicated by 

the When there is not enough free space... option are reached. 

 

Maintenance of the local database can also be performed: 

 

 

 

ICON 1 
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OPTIONS DESCRIPTION 

Create database It creates the database indicated in the database location again. 

Compact database It compacts the current database, that is, it reduces its size and makes the local queries 

faster. 

Delete all studies It deletes all studies that are stored locally. 
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13.5. RIS CONFIGURATION 

To configure the RIS parameters, users have to open the Tools > Configuration menu and select the RIS 

Listener option (ICON 1). 

 

A configuration option will be displayed as the one shown below: 

 

 
 

Users can enable or disable the option for the Starviewer to be integrated with a RIS. 

 

To enable it, users have to select the Listen to RIS requests on port option and configure the port through which 

the RIS will send the retrieval requests. 

 

It is possible to indicate that a study requested by the RIS is automatically displayed once it has been retrieved 

by checking the Automatically view the studies upon reception option. 

  

 

 

 

ICON 1 
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13.6. DICOMDIR CONFIGURATION 

To access the DICOMDIR configuration, users have to open the Tools > Configuration menu and select the 

DICOMDIR option (ICON 1). 

 

The configuration window is displayed: 

 

 
 

Different parameters can be configured: 

 

13.6.1. DICOMDIR creation configuration 

 

OPTIONS DESCRIPTION 

Convert all images to Explicit Little Endian If enabled, it automatically converts all images to Explicit 

Little Endian when creating a DICOMDIR. 

 

13.6.2. CD/DVD burning application configuration 

 

OPTIONS DESCRIPTION 

Application path It is the directory where the program to burn CD and DVD is installed. 

Application parameters They are the parameters that allow users to configure the CD and DVD 

burning application. 

 

 

 

13.6.3. Copy folder content to DICOMDIR 

Starviewer can be configured so that each time a DICOMDIR is created it automatically adds the content of a folder 

(files and subfolders). Users can choose in which case the folder content has to be copied: when creating a USB 

 

 

 

ICON 1 
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and/or when creating a CD/DVD. The path of the folder to be copied has to be indicated in Folder path to copy content, and the 

application has to be restarted. 
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13.7. EXTERNAL APPLICATIONS CONFIGURATION 

To access the external applications configuration, users have to open the Tools > Configuration menu and select 

the External application option (ICON 1). 

 

External applications consist in a URL that can be opened in the browser or executed as a system command. 

Users can add new ones with the “Add URL” or “Add command” buttons. If a URL or command has the following 

parameters, then these will be replaced by their corresponding actual values at the time of execution. If it is opened 

with the browser, then the special characters will be encoded with the percentage method (also known as “url 

encoding”). 

 

- {%StudyInstanceUID%} Study UID. 

- {%SeriesInstanceUID%} Series UID. 

- {%AccessionNumber%} Accession number. 

- {%PatientID%} Patient ID. 

 

The risks when defining external applications must be taken into account. Through a malicious DICOM file, code 

injection attacks can occur through the invocation of commands. Files can also be altered through MITM attacks 

between the user and the PACS server. 

 

The order of the external applications is taken into account when generating the menu and the assignment of the 

keyboard shortcuts. To change it, users have to select a row from the table and use the “Up” and “Down” buttons. 

 

 

 

 

 

ICON 1 
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14. SHORTCUTS 

14.1. MAIN SHORTCUTS 

 

 

14.2. OTHER IMPORTANT SHORTCUTS 
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Axial view Ctrl + 1 

 
New window Ctrl + N 

 
Open angle  + A 

 
Sagittal view Ctrl + 2 

 
Open files Ctrl + O 

 
Polygonal area  + R 

 
Coronal view Ctrl + 3  Open DICOMDIR Ctrl + D  Erase all annotations Ctrl + E 

 
Capture current image Ctrl + S 

 
Explore local studies Ctrl + L 

 
Restore Ctrl + R 

Capture the whole series Ctrl + A 
 

Search the PACS Ctrl + P 
 

Maximise to multiple screens Ctrl ++ M 

 
Unsynchronise all viewers  + U  

Magnifying glass  + Z  Move window to another screen Ctrl ++  

 
External applications  + F1 ... F12       
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15. GLOSSARY 

 

AE Title: The AE Title (from Association Entity Title) is the identifier used by the DICOM protocol to recognise the parts implied in 

communication and image transfer operations. Therefore, each PACS and workstation has its own AE Title associated to a TCP/IP 

address with which the communications between them are negotiated. 

 

DICOM: DICOM (from Digital Imaging and Communications in Medicine) is a standard for manipulating, storing and transmitting 

medical imaging information. The standard includes a definition of the DICOM file format and the communication protocols, based in 

TCP/IP, which allow the exchange of information between two entities that have the ability to send and receive information in DICOM 

format. DICOM was developed to allow the integration and communication of scanners, radiographic devices, servers, workstations 

and a large variety of hardware from different vendors. 

 

PACS: PACS (from Picture Archiving and Communication System) is a system formed by the combination of hardware and software 

dedicated to the storage, retrieval, administration, distribution and presentation of medical imaging. The universal format for the 

storage and transfer of images is DICOM. 

 

Query/Retrieve: DICOM service that allows a workstation to search for images and retrieve them from a PACS. 

 

Store: DICOM service used for sending images or other persistent objects to a PACS or to a workstation. 

 

 

 

 

 


